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Getting Started

System Requirements
To use the Eudora Light electronic mail (e-mail) application (hereafter referred to
as Eudora), you must have the following:

• A Macintosh Plus or later model, with a high-density disk drive.

• Macintosh System 7.0 or later.

• A mail account with an Internet service provider or an Internet-style network
account.

• Access to your mail account via modem or Internet-style network connection.

Drag and Drop Requirements
If you do not have Macintosh® Drag and Drop running on your Macintosh,
certain features may be disabled. Macintosh Drag and Drop is included in System
7.5 and System 7 Pro, but is not in earlier versions of System 7.

Macintosh Drag and Drop requires that Finder 7.1.3 or newer is running for the
Drag and Drop extensions to work properly. Installing the Drag and Drop
extensions with an older Finder has been shown to cause strange behavior, and is
not recommended.

If you are running a system version with a Finder that is older than 7.1.3, you will
be able to drag and drop within the Eudora application. However, you will not be
able to drag between Eudora and other running applications.

Installing Eudora
You can install this version of Eudora over an earlier version of Eudora Light.
Just follow the instructions below, and when you open the new version of Eudora,
your Settings, mailboxes, etc. will be updated for the new version.

To install Eudora, do the following:

1. Copy the Eudora Light software onto your hard disk. The latest version of
Eudora Light for the Macintosh can be found on ftp.eudora.com. (If you
are installing from diskettes, skip to the next step.)
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2. Restart your Macintosh while holding down the shift key. This turns off
your Macintosh extensions. (You must hold down the shift key until you
see the message “Extensions off.”)

3. If you are installing Eudora from diskettes, insert Eudora Light diskette 1
of 2 into your Macintosh diskette drive.

4. Double-click on the Eudora Light Installer icon to start the installation
program. The Eudora Light splash screen is displayed. Click Continue to
display the Eudora README window.

Note: The contents of the README window can be printed or saved
to a file for later review.

5. Once you have reviewed the contents of the README window, click
Accept. The Eudora Install dialog is displayed, allowing you to select
which items you want to install. To see a description of an item, click on
the item (the description is displayed just below the selection area).

Eudora Install dialog

6. To install all of the items, select the default item Eudora Light and click
Install.

To install just the items you want, select them by clicking on each one
(hold down the command key to select multiple items, and be sure that
the Eudora Light item is not selected), then click Install.
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If you selected the Eudora Light installation item, the Restart dialog is
displayed, informing you that your Macintosh will need to be restarted at
the end of the installation. Click Yes.

The Eudora Version Selection dialog is displayed, allowing you to select
which version you want to install.

Eudora Version Selection dialog

The Eudora Version Selection dialog allows you to select from the
following versions:

680x0
This is the smallest version. It runs on any Macintosh, including Power
Macs, but on Power Macintoshes it is not as fast as the PowerPC or
Universal versions.

PowerPC
This version runs only on Power Macintoshes. It does not run on standard
680x0 machines.

Universal (or Fat)
This version requires the most disk space. It runs on any Macintosh, and
on a Power Macintosh runs as fast as the PowerPC version.
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7. Select the version you want. A dialog is displayed asking you where you
want to install the Eudora Light 3.0 Folder.

Eudora destination dialog

8. Select the destination folder and click Install. The install program begins
installing the items you selected onto the appropriate locations on your
disk.

9. If you are installing Eudora from diskettes, insert the appropriate
installation diskette when you are prompted.

10. Once the installation is complete, you are prompted to restart your
Macintosh. Click Restart.

The Restart alert

This completes the installation of the Eudora Light software. To find out how to
set up Eudora so that you can send and receive e-mail, see the section “Opening
and Configuring Eudora.” For details about the files in the Eudora Folder (in your
System Folder) and the Eudora Light Application Folder, see their corresponding
sections in the Reference chapter.
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Installing Connection Tools
To use Eudora with the Communications Toolbox, the Apple Modem Tool and
Serial Tool must be installed on your Macintosh. To do this, drag the Connection
Tools folder onto your System Folder.

Opening and Configuring Eudora
After you have installed Eudora, double-click on the application icon to open
Eudora. If you are installing Eudora for the first time, the Getting Started Settings
are displayed.

To send and receive messages, you must have an account on a computer running a
POP (Post Office Protocol) server, and access to a computer running an SMTP
(Simple Mail Transfer Protocol) server. Your incoming e-mail messages are
delivered to your POP account, where you pick them up and transfer them to
Eudora on your Macintosh. Your outgoing messages are sent to the SMTP server
to deliver to your recipients.

You have to provide basic information about your account, servers, and network
connection before you can send and receive messages. To do this, use the Getting
Started Settings (if this is not open, select Settings... from the Special menu and
click on the Getting Started category).

An example Getting Started Settings
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In the POP account field, type your login name for this account, an “@” sign,
and the full name of the computer. For example, if your assigned login name is
“justine,” and the name of the computer where you receive e-mail is
“pop3.qualcomm.com” type “justine@pop3.qualcomm.com” in this field.

Note: Your POP account may or may not be the same as your e-mail
address. If your e-mail address differs from your POP account, put
the e-mail address in the Return address field of the Personal
Information Settings.

In the Real name field, type your real name. It is included in the From field of
your outgoing messages.

Specify a connection method. If you are using Eudora via TCP/IP software (e.g., a
direct network connection, SLIP, or PPP), select TCP/IP. If you are using Eudora
without TCP/IP software, select Communications Toolbox, click OK, then
select Communications... from the Special menu and choose the appropriate
modem/serial communications settings.

If your POP and SMTP servers are on the same computer, you do not need to
specify an SMTP server. If they are not on the same computer, click on the Hosts
settings category and enter in the SMTP field the full name of the computer
running the SMTP server.

You are now ready to go. For a quick introduction to Eudora’s basic functions,
see the “Tutorial” chapter; for detailed explanations of all the available functions,
see the appropriate chapters.

Registering Your Copy of Eudora
Registering your copy of Eudora Light puts you on the mailing list to receive our
free electronic newsletter keeping you informed of the latest news and
information about Eudora, e-mail, messaging, and other related topics. All
information you supply is kept in strict confidence. Registration is optional, not
mandatory.

After you send the first message with your new version of Eudora Light, you are
prompted to register.
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Example of Registration Screen

Complete the registration form and click Register. The registration is put in the
queue in your Out mailbox and is sent the next time you send queued messages.

If you don’t want to register at that time, you can choose Not Now to be prompted
7 days later, or Never Register to never be prompted again. At any time, you can
choose Register Eudora... from the Help menu to display the registration form.
The Help menu, also known as the Apple Guide menu, is accessed from the
question-mark-in-the-balloon icon at the top right corner of your screen.

Quitting Eudora
To quit Eudora, select Quit from the File menu. If you have queued messages, or
timed messages due to be sent in the next 12 hours, you are given the option to
send them (see the section “Queueing a Message to Send Later”).

The Trash mailbox is emptied if the Empty Trash on Quit option is on in the
Miscellaneous Settings.
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Online Help
Eudora has an Online Help feature that provides quick-reference instructions for
accomplishing many of Eudora’s operations. To display an Online Help window,
select the topic you want from the Macintosh Help menu.

Eudora Help menu
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Eudora also has extensive Balloon Help. To turn Balloon Help on, select Show
Balloons from the Macintosh Help menu. Move the mouse pointer to a Eudora
menu selection or item on the screen to display a brief description of that item.

Balloon Help

You can use Balloon Help even when a dialog is displayed.

To turn Balloon Help off, select Hide Balloons from the Macintosh Help menu.

Note: If you have an extended keyboard with a help key, it can be used to
turn Balloon Help on and off.

More Help
If after reviewing all of the available materials—this user manual, the README
files, the online help, and the balloon help—you still need help, contact your
e-mail administrator (your Internet service provider or your company’s Eudora
support coordinator), or check out the Eudora Usenet news group
comp.mail.eudora.mac. Because of the similarity of Eudora between Macintosh
and Windows platforms, you may also find your answer on the Eudora Usenet
news group comp.mail.eudora.ms-windows.
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Introduction
This tutorial introduces Eudora’s basic functions. There are a host of other
operations not described here. For detailed explanations of all available Eudora
functions, see the following chapters.

Creating an Outgoing Message
A good way to familiarize yourself with Eudora is to create an outgoing message.
An outgoing message is one that you send to someone else.

From the Message menu, select New Message. A new composition window is
displayed. Since it is easiest to experiment with Eudora by sending a message to
yourself, type your own e-mail address in the To field.

The From field has been automatically filled in and can’t be altered. This is your
real name and return address (as entered in the Real name and Return address
fields in the Personal Information Settings).

Press the tab key or point and click the mouse to move the cursor down to the
Subject field. Typically, you would enter some brief text indicating what the
message is about. For this message, type the words Test Message.

Move the cursor past the remaining Cc, Bcc, and X-Attachments fields down
into the large area below them. This area is reserved for the body of the message.
Here you can type whatever text you want. When you finish your message
(referred to in this tutorial as your test message), the composition window should
look something like the example below.

QUALCOMM Incorporated 23



Tutorial Eudora User Manual

Example test message

Saving the Message
To save any current outgoing message, such as your test message, select Save
from the File menu. This saves the message in its current state in the Out mailbox,
which holds all outgoing mail.

After you save your test message, select Out from the Mailbox menu to view the
message summary. The bullet (•) in the Status column of the message summary
indicates that the message has been saved and can be sent or queued.

A message saved in the Out mailbox
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Sending the Message
Notice the Send button in the upper right hand corner of the composition window
(see the note below if this button says Queue). To send the message, simply click
on this button.

Sending the message

The composition window immediately closes, and the progress window is
momentarily displayed at the top of the screen. The progress window shows you
the progress of lengthy operations.

Note: If the button says Queue instead of Send, select Settings... from the
Special menu, click on the Sending Mail icon in the Settings
dialog, turn on the Immediate send option by clicking in the
checkbox next to it to put an “x” in the box, then click the OK
button to save the setting. The button in the composition window
changes to Send.

Checking for and Receiving the Message
There are two ways to check your POP server to see if you have any new
incoming mail. One way is to set up Eudora to automatically check for mail every
so often. The other way is to check for mail manually whenever you want to by
selecting Check Mail from the File menu. Do this manual check now.

Your password is requested for the first mail check after Eudora is opened,
whether it is an automatic check or a manual check.

Note: Your POP account password is provided by your e-mail administrator.
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The Password dialog

Type in your password and click OK. If you make a mistake before clicking OK,
simply backspace and re-enter the password correctly. If your password is
rejected, select Check Mail from the File menu again and re-enter your password.

Note: Your Eudora password is case-sensitive, so the uppercase and
lowercase letters must be typed in exactly. Be sure caps lock is off.

After you successfully enter your password, a progress window is momentarily
displayed at the top of the screen indicating that an attempt to reach your POP
account is being made. If there is a network problem between you and the POP
server, an alert is displayed. Consult with your e-mail administrator to solve the
problem.

If there is no mail waiting at your account on the POP server, the You have no
new mail alert is displayed. This means that the message you sent to yourself in
the previous exercise has not been delivered to your POP account yet. Click OK.

Keep selecting Check Mail from the File menu until your test message arrives. If
the message doesn’t arrive in a minute or two, notify your e-mail administrator.

When mail is found in your POP account, it is transferred to your Macintosh and
the progress window lets you monitor the transfer. This is followed by the You
have new mail alert.
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Click OK. The In mailbox window is displayed with your test message summary
listed inside.

The test message listed in the In mailbox

The mailbox window shows a summary of each message in the mailbox.
Incoming messages are stored indefinitely in the In mailbox until they are deleted
or transferred to another mailbox (as described later in this tutorial).

To select (highlight) the message summary, click anywhere on the summary. To
open the message, double-click on its summary. Do this for your test message to
display it on your screen.

The incoming test message

The Current Message
Most Eudora commands can be applied either to an open message window or to
highlighted message summaries in a mailbox window. This lets you apply
commands (such as Transfer, Forward, and Reply) to messages without opening
them first. Whenever the term current message is used in this manual, it refers to
a message that is open and is in the topmost window or whose message summary
is highlighted within a mailbox window.
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Replying to the Message
You can easily reply to the sender of an incoming message without having to
create a new message from scratch.

With the test message current, select Reply from the Message menu to initiate a
reply to the message.

A new composition window is displayed, with the sender’s address (in this case,
your own) automatically placed in the To field of the header. The original
sender’s text is automatically included in the body of the message. You can edit
this text as needed (or it can be deleted by pressing the delete key). You can enter
more text in the reply message just as in any outgoing message. In your test reply,
move the insertion point to the area below the original message and type in some
additional text. To send this message, click Send.

A reply to a message

Transferring the Message Between Mailboxes
You can organize your incoming mail by creating new mailboxes and easily
transferring messages among them.

To create a new mailbox and transfer your test message into it, open the In
mailbox, select your test message summary, and select New... from the Transfer
menu. The New Mailbox dialog is displayed. Any name can be typed in the new
mailbox title field, but for this example, type Testing.
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New Mailbox dialog

Click OK to create the new mailbox. Because your test message was highlighted
when you selected New... from the Transfer menu, it is automatically transferred
into the Testing mailbox. To see this, select Testing from the Mailbox menu.

You can also transfer messages among existing mailboxes. To do this, select your
original test message from the Testing mailbox and then select In from the
Transfer menu.

Transferring the test message

Deleting the Message
Messages are stored indefinitely in any mailbox until they are deleted or
transferred to another mailbox. Any current message can be deleted.

To delete your test message, open it or select it in the In mailbox. Then, select
Delete from the Message menu. As a safeguard, the Delete command doesn’t
actually delete messages, but instead transfers them to the Trash mailbox. So, if
you suddenly realize that you deleted a message you want to keep, you can
transfer it out of the Trash into another mailbox.
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All messages stored in the Trash mailbox are automatically deleted when you quit
Eudora (although you can turn this option off). To manually delete messages in
the Trash mailbox, select Empty Trash from the Special menu.

Warning: An extreme version of the Delete command is the Nuke
command, which you can select by holding down the shift and
option keys while pulling down the Message menu. Nuke
deletes the message without first transferring it to the Trash
mailbox—that is, it permanently removes the message from
your Macintosh. Be sure you know what you’re doing when
using Nuke!  You cannot undo a Nuke operation!
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Creating an Outgoing Message
An outgoing message is a message you send to someone else. To create an
outgoing message, select New Message from the Message menu. A new message
window is displayed, called the composition window. The section below describes
how to use the composition window.

Using the Composition Window
The composition window consists of the title bar, the icon bar, the message
header, and the message body.

The composition window

Title Bar
The title bar provides information about the message, including the name of the
addressee, the time and date the message was sent, and the message subject.

Note: Double-clicking on the title bar opens the mailbox that the
message resides in.
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Icon Bar
The icon bar consists of a series of objects that are displayed just under the title
bar. It allows you to control the priority of your message, override some of your
default settings for the current message, and send or queue the message. Each icon
can be turned on or off for the current message by clicking on it. A checkmark
symbol next to the icon means the icon is on. The popup menus and icons are
described below.

You can set the defaults for the icon bar in the Sending Mail Settings and the
Attachments Settings.

Priority Popup
This lets you indicate that your message is of higher or lower priority than a
normal message. For most messages, this is just an empty box (normal priority).
For details, see the section “Setting the Message Priority.”

Signature Popup
This lets you automatically append one of your signatures to the end of a
message. For details, see the section “Using Signatures.”

Attachment Type Popup
This lets you select the encoding format for attachments. For details, see the
section “Attaching a File to a Message.”

Quoted-Printable Encoding
If this is on, quoted-printable encoding is used when sending messages or plain
text attachments that contain long lines of text or special characters. It is
recommended that this always be on.

Include Macintosh Information
If this is on, the Macintosh file-type and resources are included in AppleDouble
and AppleSingle attachments. For details, see the section “Attaching a File to a
Message.”

Word Wrap
If this is on, a carriage return is not required at the end of each line. When the
message is sent, the text is automatically “wrapped,” meaning that carriage
returns are inserted at the end of each line of text, with roughly 76 characters per
line.

Keep Copy
If this is on, a copy of each sent message is kept in the Out mailbox. These
messages are saved there until they are deleted or transferred.
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Send or Queue
These let you send a message immediately or put it in the queue to send later. If
the Immediate send option in the Sending Mail Settings is on, the button is
labeled Send. If the option is off, the button is labeled Queue. For details, see the
section “Sending or Queueing a Message.”

Message Header
Outgoing mail headers consist of six fields: To, From, Subject, Cc, Bcc, and
X-Attachments. Each field is described below. The To, Subject, Cc, and Bcc
fields can be directly edited. To move the cursor from field to field, press the tab
key or click in the desired field with the mouse.

To
The intended recipients’ e-mail addresses, or nicknames you have defined (see the
chapter “Using the Address Book and Quick Recipient List”). Multiple addresses
and nicknames must be separated by commas.

From
The sender’s e-mail address. This is usually your POP account plus your real
name. You can use a return address other than your POP account by entering the
address in the Return address field of the Personal Information Settings.

Subject
Some brief text indicating the contents of the message. This field can be left blank
(though it is considered a breach of e-mail etiquette to do so).

Cc
The e-mail addresses or nicknames of people to whom a copy of the message is to
be sent. These recipients are displayed in the message header for all recipients to
see. Multiple addresses must be separated by commas. This field can be left
blank. Cc stands for “carbon copy.”

Bcc
The e-mail addresses or nicknames of people to whom a copy of the message is to
be sent. These recipients are not displayed in the message header, and the
recipients in the To or Cc fields will not know that a copy went to these
addresses. This is useful when you want to send a copy of a message to someone
without everyone else knowing you did so. Multiple addresses must be separated
by commas. This field can be left blank. Bcc stands for “blind carbon copy.”
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X-Attachments
A list of documents being attached to and sent along with the message. See the
section “Attaching a File to a Message” for instructions on how to add
attachments. To delete an attachment from an outgoing message, select it and
press the delete key. This field can be left blank.

Message Body
After filling in the header fields, move the insertion point to the space below the
message header. Type the body of the message here. For information about
formatting your message text, see the section “Formatting Text.”

Saving a Message for Later Changes
Sometimes it is convenient to save an outgoing message either as a safeguard
when typing long messages, or so you can return to it later to make changes.

To save the current message, select Save from the File menu. To save all of the
messages that you have open, hold down the option key and select Save All from
the File menu.

Saved messages are put in the Out mailbox, and if at least one recipient is entered
in the To: field or the Bcc: field, the saved message is shown with a bullet (•) in
the Status column. If the To: and Bcc: fields are both empty, the Status column is
blank. The bullet indicates that the message not only has been saved but can also
be sent or queued.

A saved (and sendable) message in the Out mailbox

You can continue making changes to the message or close it. If you try to close an
outgoing message window without saving that version of the message, an alert is
displayed asking if the message should be saved or the changes discarded. If you
select Discard and the message has never been saved, the message is deleted.
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Using Signatures
A signature is a few lines of text that are automatically added to the end of an
outgoing message when it is sent. A signature can be whatever you want, but it is
mostly used to give contact information (telephone, address, etc.). You can have
two signatures: your Standard signature and your Alternate signature.

Note: Your signature is not displayed in the Eudora message window, but
is added to the end of the message when it is sent.

To create or modify your Standard signature, select Signatures→Standard from
the Special menu. The Standard signature window is displayed. Enter your
signature text, and select Save from the File menu to save your changes.

Creating the Standard signature

To create or modify your Alternate signature, select Signatures→Alternate from
the Special menu. The Alternate signature window is displayed. Enter your
signature text, and select Save from the File menu to save your changes.

To include a signature in an outgoing message, select the signature you want from
the Signature popup on the icon bar.

Setting the signature for a particular message
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To include your Standard signature in all of your outgoing messages, open the
Sending Mail Settings and check the Use signature option. You can turn this off
for a particular message by selecting Alternate Signature or None from the
Signature popup.

Setting the Message Priority
You can assign a priority to incoming and outgoing messages. The priority is only
for you and your recipients—it does not affect the way mail transport systems
handle the messages.

There are five priority levels available, 1 being the highest, 5 being the lowest.
Each is represented by a small symbol in the icon bar of a message window and
the Priority column of a message summary. Priority 3 is used for messages that
have no assigned priorities, and it is not displayed. The high and highest priority
symbols are red. You can also use Raise or Lower to set the priority one level
higher or lower, instead of setting a particular priority level.

New messages are created with a Normal priority. To change the priority of the
current message, use the Priority popup.

Changing the priority of a message using the Priority popup

Note: To set up Eudora to always use the sender’s priority on your
replies, turn on the Copy original’s priority to reply option in the
Replying Settings. You can always change the priority in the
message window.
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Formatting Text
A Note on Styles
Eudora Light supports the viewing and copying of styled text in incoming
messages but not the creation of styled text in outgoing messages.

If you copy styled text from an incoming message using the Copy command on
the Edit menu, the style information is preserved. You can then paste the styled
text into another application, and you will see the styles, depending on which ones
the application (and the computer) supports. But if you try to paste that text into a
new outgoing message, the style information will be lost.

Similarly, if you drag styled text from an incoming message and drop it into a
new outgoing message, the style information is lost. (Dragging styled text to
another application preserves the styles depending on the application and your
computer.) Style information is also lost if you Reply to, Forward, or Redirect
an incoming message that has styled text.

The Styled Text Settings let you specify how you want to receive styled text.

Other Formatting Options
To copy styled text without taking the styles, hold down the shift key and select
Copy Without Styles from the Edit menu.

If you turn on the Word Wrap icon in the composition window, you do not need
to use carriage returns in the body of your message. When you send the message,
the text is automatically “wrapped,” meaning that carriage returns are inserted at
the end of each line of text, with roughly 76 characters per line. This makes the
message legible on the recipient’s computer.

To manually wrap text, select the text you want, then select Wrap Selection from
the Edit menu. To unwrap text, select the text you want, then hold down the
option key and select Unwrap Selection from the Edit menu.

To copy wrapped text without taking the carriage returns, hold down the option
key and select Copy & Unwrap from the Edit menu.

To copy wrapped and styled text without taking the carriage returns or styles, hold
down the shift and option keys and select Copy Without Styles & Unwrap from
the Edit menu.

To move text around in your messages or text files, or to move text from other
application windows into your Eudora windows, use the Macintosh standard Drag
and Drop functions.

QUALCOMM Incorporated 37



Sending Messages Eudora User Manual

Attaching a File to a Message
Any Macintosh file can be attached to and sent with a Eudora message. An
attached document functions like a “rider” to the e-mail message, and does not
appear within the message text. Instead, the name of the document and its icon are
displayed automatically in the X-Attachments field of the message header.

To attach a file to a current outgoing message, select Attach Document... from
the Message menu. A standard file dialog is displayed. Once the desired
document is located, select it and click on the Attach button to attach the
document to the message. You can add as many attachments as you want.

You can also drag one or more files from the Desktop onto the message window
to attach them.

An outgoing message with an attached document

To detach a document before the message is sent, select the document in the
X-Attachments field, then press the delete key.

When the message is sent, if the chosen document is not a plain (ASCII) text file,
it is encoded in the selected attachment type. This allows you to send any kind of
document through the mail, even Macintosh applications.

The MIME (Multipurpose Internet Mail Extensions) standard uses Base64
encoding. It is the newest form of encoding and is a good choice for sending files
to either platform. However, since it is a new standard, only use this method if
you know your recipient is using a mailer that supports MIME.
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The attachment types include the following:

  AppleDouble
This is best for recipients with MIME-compliant e-mail readers, regardless of
what operating system they are using. For more information on MIME, see
Appendix G.

  AppleSingle
This works for recipients with MIME-compliant e-mail readers on Macintoshes.
Do not use this type if your recipient is using a PC.

  BinHex
This is best for recipients on a Macintosh with an e-mail reader that is not MIME-
compliant.

If you want to include the Macintosh file-type and resources with an AppleDouble
or AppleSingle attachment, be sure the Include Macintosh Information icon is
checked. This can be important in maintaining the integrity of the file for another
Macintosh, but will confuse other operating systems.

If the chosen document is a plain text file, it is not encoded in any special format
before being sent, but the Include Macintosh Information icon can be used to
force the document to be encoded with the chosen encoding.

Sending Attachments to Non-Eudora Users
If you send an attachment to someone who doesn’t use Eudora, the attached file
may be included at the end of the message in the chosen attachment format
(AppleDouble, AppleSingle, or BinHex). Your recipient should save the message
as a file, then decode the file using an application appropriate for the encoding
method you used when you sent the message.

Inserting a File into a Message
The contents of a text file can be inserted directly into a message (and then edited
if desired). To insert a text file into a message, put the cursor where you want the
text inserted, and select Attach Document... from the Message menu. Then select
the text file you want and click on the Insert button. The text from the file is
inserted into your message and you can edit it as normal.
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Including a URL in a Message
To include a URL (Uniform Resource Locator) in a message, enclose it with less
than and greater than signs to ensure that your recipient’s application can identify
it as a URL. For example, <http://www.eudora.com>. The URL is automatically
highlighted as an active URL in your message window.

A URL in an outgoing message

Sending or Queueing a Message
After you compose a message, you can send it immediately, or put it in a queue to
be sent sometime later or at a specified time.

Sending a Message Immediately
If you want to send your messages immediately instead of putting them in a queue
to send later, then be sure the Immediate send option is on in the Sending Mail
Settings.

To send the current message, click on the Send button or select Send Message
Now from the Message menu. A progress window is displayed to show the
progress of the transmission.

If you have the Immediate send option on, but want to put the current message in
the queue, hold down the option key and click on the Send button. The Change
Queueing dialog is displayed and you can set detailed instructions. For more
details, see the section “Queueing a Message to Send at a Certain Time.”
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Queueing a Message to Send Later
If you want to put your messages in a queue (in the Out mailbox) to send all
together at a later time, be sure the Immediate send option is off in the Sending
Mail Settings.

To put the current message in the queue, click on the Queue button or select
Queue Message from the Message menu. The message window is closed (if it
was open) and the message is saved in the Out mailbox marked Q (meaning it’s
ready to be delivered).

Queued messages in the Out mailbox

To send all of your queued messages, select Send Queued Messages from the
File menu. A progress window is displayed momentarily at the top of the screen
indicating the progress of the transmission.

If you have the Immediate send option off, but want to send a message
immediately, hold down the option key and click on the Queue button. The
Change Queueing dialog is displayed and you can select the Send message
Right Now option.

You can set up Eudora to warn you if you try to delete a queued message, or try to
quit Eudora with queued messages. To do this, turn those options on in the Extra
Warnings Settings.

Queueing a Message to Send at a Certain Time
You can specify that a message be sent at a certain time in the future. To do this
for the current outgoing message, select Change Queueing... from the Message
menu. The Change Queueing dialog is displayed.
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The Change Queueing dialog

If you choose Right Now, the message is sent immediately when you click OK. If
you choose Next Time Queued Messages are Sent, the message is sent the next
time queued messages are sent.

If you choose On or after, you can use the Time and Date fields to fill in the
time and date when the message should be sent. The message is saved in the Out
mailbox with a T in the status column, and is sent when the specified time arrives.

Note: For the message to be sent at the correct time, Eudora must be
running when the message is due to be sent. If Eudora is not
running, the message is sent the first time Eudora is run after the
selected time has passed.

If you choose Don’t Send for a message that has never been queued, nothing
happens. If the message has been queued already, the message status is changed
from queued (Q) to sendable (•). The message is held in the Out mailbox until it is
either deleted or re-queued and sent.

Editing a Queued Message
To edit a queued message, open the Out mailbox and double-click on the message
summary. Make the necessary edits and save them. The message is returned to the
Out mailbox. If you close the changed message without saving it, an alert is
displayed asking you to verify the changes.
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Taking a Message Out of the Queue
A message that is queued but not yet sent can be unqueued using the Change
Queueing command. Open the Out mailbox and select the desired message
summary. Then select Change Queueing... from the Message menu and click on
Don’t Send. This changes the message status from queued (Q) to sendable (•).
The message is held in the Out mailbox until it is either deleted, re-queued, or
sent.

Sending Queued Messages When Checking Mail
If the Send on check option in the Sending Mail Settings is on, every time Eudora
checks for mail (automatically or manually), all queued messages are
automatically sent.

Replying to a Message
To reply to the current message, select Reply from the Message menu. A new
message window is displayed, with the original sender’s address automatically
placed in the To field of the header. All of the sender’s original text is quoted in
the message body, with each line prefixed by a greater-than symbol (>).

Quoted text in a reply

This text can be edited as needed. Additional text can be added to the reply just as
to any outgoing message, and the reply can then be sent or saved for further
changes.

Messages that have been replied to are identified with an “R” in the Status column
of their message summary.

Note: When you reply to a message that contains styled text (e.g., bold),
the style information is lost.

Using the Reply Functions
There are several options that you can use when replying to messages.

To quote only some of the sender’s text, select the text you want, then hold down
the shift key and select Reply Quoting Selection from the Message menu.
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To include everyone who received the original message, hold down the option key
and select Reply To All from the Message menu. Or, turn on the Reply to all By
default option in the Replying Settings and the Message menu option changes to
Reply To All. In this case, you must hold down the option key to create a reply to
only the original sender.

To include yourself as a recipient, turn on the Include yourself option in the
Replying Settings. This only works if you are using Reply To All.

Note: To determine who you are, Eudora uses the “me” nickname, if you
create one for yourself. If not, Eudora uses the contents of the POP
account and Return address fields from the Personal Information
Settings.

To put the addresses of the other recipients of the original message in the Cc field
(instead of the To field), turn on the Put original To recipients in Cc field, not
To field option in the Replying Settings. Only the original sender’s address is put
in the To field. This only works if you are using Reply To All.

To copy the original message’s priority to your replies, turn on the Copy
original’s priority to reply option in the Replying Settings.

Forwarding a Message
Any message can be forwarded to someone else. To forward the current message,
select Forward from the Message menu. A new message window is displayed
with your address in the From field and the original sender’s text quoted in the
message body (each line is prefixed by a greater-than symbol, >). Make any
changes you want, and enter the recipients’ address in the To field. The message
can then be sent or saved for further changes.

To forward a message with just the original text without quote characters, hold
down the option key and select Forward from the Message menu.

Messages that have been forwarded are identified with an “F” in the Status
column of their message summary.

Note: When you forward a message that contains styled text (e.g., bold),
the style information is lost.
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Redirecting a Message
Incoming messages can be sent to a new recipient “by way of” you, maintaining
the original sender’s address in the From field. This is called redirecting.

To redirect the current message, select Redirect from the Message menu. A new
message window is displayed with the original sender’s address in the From field
with the statement “by way of your name,” and the original sender’s text in the
message body. Make any changes you want, and enter the recipient’s address in
the To field. The message can then be sent or saved for further changes.

Note: You may want to enclose any changes in brackets ([]) so that you
don’t confuse the recipient about who wrote what.

A redirected message

Messages that have been redirected are identified with a “D” in the Status column
of their message summary.

Note: When you redirect a message that contains styled text (e.g., bold),
the style information is lost.

Turbo Redirecting
You can redirect one or more messages to someone on your recipient list, queue
the new message (without displaying it), and delete the original message, all with
one command. To do this, hold down the option key and select Turbo Redirect
To→Recipient from the Message menu.

To Turbo Redirect a message without deleting the original, hold down the shift
and option keys and select Turbo Redirect Without Delete To→Recipient.
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To make Turbo Redirect the default menu option, turn on the Turbo redirect by
default option in the Miscellaneous Settings. To do a regular redirect with this
option on, hold down the option key and select Redirect To.

Redirect and Signatures
When you use Redirect, your signature is not added to the message when it is
sent, unless you originally created the message. Eudora considers the message to
be originally from you if the address in the From field exactly matches your
return address or one of the addresses belonging to your nickname called “me.”

Keeping Copies of Outgoing Messages
There are two ways to keep copies of your outgoing messages.

To put a copy of every outgoing message in the Out mailbox, turn on the Keep
copies of Outgoing Mail option in the Sending Mail Settings.

To put a copy of the current outgoing message in the Out mailbox, turn on the
Keep Copy icon in the icon bar (there should be a checkmark next to it).

In each case, when the messages are sent they are put in the Out mailbox with an
S in the Status column, indicating that the message has been sent.

If neither option is used, outgoing messages are put into the Trash mailbox.

Note: You can also set up a filter to save outgoing messages in particular
mailboxes based on information contained in the message. See the
section “Filtering Messages” for more information.

Sending Rejected Messages Again
If for some reason an e-mail message can’t be delivered to a recipient, mail
transport agents return the message to the original sender (you). A message is
typically rejected because of an error in the recipient’s address, although many
other reasons are possible.

The return message usually includes cryptic information that may let you
determine the reason the message was rejected. It also includes the text of the
original message.

You can easily recover the original message, make any corrections, and resend it.
To do this for the current message, select Send Again from the Message menu.
This eliminates the inserted extra text and reformats the message as it originally
appeared. You can then make changes or additions and send the message again.
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Checking for Incoming Mail
The POP server is where your mail is received and stored until it is transferred to
Eudora on your Macintosh. Your POP server account is specified in the Getting
Started Settings.

Note: To best understand the functioning of the POP server with respect
to Eudora, see Appendix C.

There are two ways to check your POP server and transfer mail to your
Macintosh: automatically or manually. These are described in the sections below.

Checking for Mail Automatically
You can set up Eudora to automatically check your POP server and transfer new
mail every so often. To do this, select Settings... from the Special menu, and
select the Checking Mail Settings. Turn on the Check for mail every ? minutes
option, and enter the number of minutes that you want between mail checks
(Eudora must be running, but you can be using other applications on your
Macintosh). For example, if you type in 15, Eudora checks for mail every 15
minutes. In fact, 15 minutes is a good minimum interval, because checking mail
more frequently puts an unnecessary load on your POP server.

Eudora will check for mail at the intervals you have requested, unless you’re
actively using Eudora (e.g., when you’re typing a message, or reading mail). You
must leave Eudora alone for at least a minute before it will check for mail.

Note: If automatic checking is set, the Check Mail command under the
File menu displays the next time that an automatic check is
scheduled to occur.
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Checking for Mail Manually
You can check for mail manually at any time by selecting Check Mail from the
File menu. If you haven’t successfully entered your password since opening the
Eudora program, you are prompted for it. A progress window is momentarily
displayed at the top of the screen indicating that an attempt to reach your POP
account is being made.

Note: If automatic checking is on and you manually check for new mail,
the next automatic mail check will happen at the specified number
of minutes after the manual check.

Stopping a Mail Check
If you want to stop a mail check in the middle, click on the Stop button in the
progress window, or hold down the command key and type a period (.), or press
the escape key (marked esc).

Using Your Password
Each time you open Eudora and check mail for the first time, you need to enter
your password. In the Password dialog, type in your password and click OK. If
you make a mistake before clicking OK, simply backspace and re-enter the
password correctly.

Entering your password

Note: Your POP account password is case-sensitive, so the uppercase
and lowercase characters must be typed in exactly.

If your password is rejected, an error message is displayed indicating that you
have entered the wrong password.
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Wrong password

Select Check Mail from the File menu to redisplay the password dialog.

As long as Eudora is running, it remembers your password. If you don’t want it to
remember (if, for example, you are away from your Macintosh), select Forget
Password from the Special menu. The next time you check mail, you are
prompted for your password again.

You can also make Eudora remember your password from one session to the next,
which means you never have to enter your password again, even if you quit and
open Eudora again. You only want to do this if your Macintosh is in a secure
location, where there is no possible chance of someone else having access to it.
To use this option, turn on Save password in the Checking Mail Settings.

Changing Your Password
To change your POP account password, select Change Password... from the
Special menu. (This command only works if your POP server is running a
compatible password-change server. For information about these servers, see
Appendix A.) You are prompted to enter your old password once, and your new
password twice. Depending on the server you are using, the password can be up to
30 characters, but normally it is only 7 or 8.

When you choose a new password, try not to use real words, names, dates,
familiar acronyms, etc. Some servers require at least one number or symbol in
your password, and you may want to do that even if it is not required.
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Receiving New Mail
When Eudora does a mail check, you can be notified of new mail in one or all of
the following ways: an alert dialog, a flashing mail icon in the menu bar, the
opening of the mailboxes to which new mail is delivered, and a special “New
Mail” sound. These options are turned on or off in the Getting Attention Settings.

When you receive notice that new mail has arrived, select Eudora from the
applications menu. Mail usually arrives in the In mailbox (unless you are using
filters to transfer messages). If the In mailbox is not already open, select In from
the Mailbox menu. The messages are listed in the order they are received, with
the most recent message listed last. Unread messages are designated by a bullet (•)
in the Status column of the message summary.

Unread messages in the In mailbox

Double-click anywhere on a message summary to open the message. Incoming
messages are saved indefinitely in the In mailbox (or the mailbox they are filtered
into) until they are deleted or transferred to another mailbox.

The Incoming Message Window
To open an incoming message, double-click on its message summary in a mailbox
window, or, if the message summary is current (highlighted), select Open
Selection from the File menu or press the space, enter, or return key.

An incoming message window
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The incoming message window consists of the title bar, the icon bar, and the
message body.

Title Bar
The Title bar provides information about the message, including the name of the
sender, the time and date the message was delivered, and the message subject.

Icon Bar
The Icon bar consists of a series of objects that are displayed just under the title
bar. To turn an icon on, click on it to put a checkmark next to it.

Priority Popup
This lets you indicate that the message is of higher or lower priority than a
normal message. For most messages, this is just an empty box (normal priority).
For details, see the section “Setting the Message Priority.”

Pencil
If this is on, you can edit the message.

BLAH BLAH BLAH
If this is on, all the message headers are displayed.

Incoming mail with all headers displayed
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Subject
This is the subject that was assigned by the sender, and is shown in the message
summary. For instructions on changing this subject, see the section “Editing
Incoming Messages.”

Fetch
If this is on, the message is transferred in full the next time you check mail. This
icon is only displayed if the message was originally transferred in part. For
details, see the section “Managing Your Mail on the POP Server.”

Tow Truck
This can be used to drag any current message into a different mailbox. Just hold
the mouse button down on the icon and drag it to an open mailbox.

Message Body
The message body contains the message header and text information, as well as
the name and icon of each attachment. Attachments can be opened from within
the message window by double-clicking on the attachment icon, or by holding
down the command key and single-clicking on the icon (see the section
“Receiving Attachments”).

You can specify what kind of text styles you want or don’t want displayed in
incoming messages. In the Styled Text Settings, just turn off the option for a style
that you don’t want to receive (e.g., bold text). All of the possible styles are on by
default.

Responding to a Request for Return Receipt
Eudora Light supports the Return Receipt option generated in Eudora Pro
messages.

Eudora Pro users who send you messages can request that you notify them when
you have seen their message. When you receive such a message and open it, in
addition to hearing a short beep, you see under the icon bar a line of text
requesting that you notify the sender that you have seen the message, along with a
Notify Sender button. If you click on the Notify Sender button, the sender
receives a message telling them when you displayed their message.
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A request for notification

If you receive a message with a request for notification of receipt, you can click
on Notify Sender to send the notification, or you can just ignore it. To remove the
request without sending the notification, hold down the option key and click on
Notify Sender.

If you close the message without taking action, each time you open the message
you will hear the short beep and see the notification request until you respond to
the request, clear it without responding, or delete the message.

Receiving Attachments
Unless you have specified a particular folder for your incoming attachments (see
the section “Specifying an Attachment Folder”), they are automatically decoded
and saved in the Attachment Folder in your Eudora Folder (which is in your
System Folder). If you receive multiple attachments with the same name, a
number is added to the end of each duplicate name, in the order they are received.

Attachment names and icons are displayed at the bottom of incoming messages.
To open an attachment from the message window, double-click on the attachment
name or its icon (you can also hold down the command key and single-click on
the attachment name or its icon). If you have the application that the attachment
was created in, that application launches and the attachment opens.

To move the attachment from one folder to another, highlight the attachment in
the message, then drag it to where you want it.

To copy the attachment to another folder, highlight the attachment in the message,
hold down the option key, then drag it to where you want it.

To find out where the attachment is located on your Macintosh, hold down the
control and command keys, then click on the attachment in the message. The
folder that holds the attachment is opened and the attachment is highlighted.
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Specifying an Attachment Folder
If you do not want to use the default Attachment Folder to receive your
attachments, select Settings... from the Special menu and select the Attachments
Settings. Then click on the large button beneath the Attachment Folder prompt. A
standard file dialog is displayed.

Double-click on the name of the folder you want to use (its name should be
displayed in the menu above the list), then click the Use Folder button. The
dialog closes, leaving the Settings dialog displayed. The name of the folder you
just selected is now displayed in the Attachment Folder button.

An attachments folder is selected

If this does not work, you may have a conflicting system extension. To get around
this problem, restart your Macintosh with all of the extensions turned off (hold
down the shift key while restarting), then open Eudora and set the Attachment
Folder again. You should be able to restart your Macintosh with all of your
extensions on and still maintain the specified folder.

Note: If at any time Eudora cannot find your selected folder, an alert is
displayed at startup informing you that the Attachment Folder is
unavailable. Eudora will use the Attachment Folder in the Eudora
Folder (in your System Folder) for attachments until you designate
a new folder.
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Editing Incoming Messages
You can edit the message body in an incoming message if you turn on the Pencil
icon in the icon bar. With the Pencil icon on or off, you can also edit the Subject
in the icon bar (this is the subject shown in the message summary).

To edit an incoming message, click on the Pencil icon to turn it on, then edit the
message body. When you are done, save your changes and close the message.
You may want to turn off the Pencil icon before closing the message, so that you
don’t make accidental changes.

To edit the subject of an incoming message, open it (remember that the Pencil
icon can be on or off) and edit the subject in the icon bar (not the subject in the
message body). When you are done, click somewhere else in the message, or
close it. The new subject is displayed in the message summary. The contents of
the Subject field of the message header remain unchanged.

Note: If you reply to the message, the original subject is used for the
reply, not your changed subject. This gives you the freedom to put
information useful to you into the summary, without fear of your
private notes being revealed to your correspondents.

Editing the subject of an incoming message

Using Active URLs
Any string of text that Eudora recognizes as a “hot link,” also known as a URL
(Uniform Resource Locator: http, ftp, gopher, ph, finger, etc.), is active. Active
URLs are normally highlighted in blue text and underlined (also in blue), and are
often enclosed by less-than and greater-than signs, “<>.” You can hold down the
command key and click on a URL (or just double-click on it) to open a World
Wide Web location, transfer a file, do a gopher search, use the finger tool, etc.

To specify what Internet application you want to use for a URL type, hold down
the option key and double-click on the URL. A standard file dialog is displayed.
Select the application you want, then click on Open. The application is opened
and goes to the selected URL. The next time you select a URL of that type, the
same application is automatically used.
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Sometimes users will send you messages containing hot links that are poorly
formatted, so that Eudora won’t recognize them as hot links. Eudora won’t turn
these text strings to blue and underline them, but you can still use them as hot
links. Simply select the entire string of text that you think is a hot link, and choose
Open Selection from the File menu, or hold down the command key and click on
the selection.

We recommend that you encourage your correspondents to enclose hot links in
angle brackets, <>, like this: <http://www.somebody.company.com/heythere/>.
This will help Eudora and other software to recognize the hot link.

Managing Your Mail on the POP Server
During a mail check, your incoming messages are normally transferred from your
account on the POP server to your Macintosh, and then deleted from the POP
server. But this can be awkward if you want to read mail from two or more
Macintoshes, and keep your mail organized at the same time.

There are several options that you can use to control your mail transfers and the
storage on the server. These options are available in the Checking Mail Settings.

Leaving Mail on the Server
To transfer all of your new messages from the POP server to the Macintosh you
are on, and also leave copies of those messages on the server, turn on the Leave
on server option in the Checking Mail Settings. You can set the number of days
the copies should be kept, or leave the field blank to store the copies indefinitely.

At the next mail check from that Macintosh, Eudora ignores the copies of those
previously read messages and looks for new ones. However, if you check mail
from another computer, those messages are treated as new and are transferred to
that computer.

Note: The Leave on server option should be used with care, since it can
result in a buildup of messages on the POP server.

Deleting Mail from the Server
To delete messages that have been left on the server (without retrieving them
again), turn on the Delete from server when emptied from trash option in the
Checking Mail Settings. Any messages you transfer to the Trash mailbox are
permanently deleted from the server when you select Empty Trash from the
Special menu or, if the Empty Trash on Quit option is turned on in the
Miscellaneous Settings, automatically when you quit Eudora.
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Note: The Delete from server when emptied from trash option should be
used with care, since messages deleted this way can never be
recovered.

Skipping Messages Over a Certain Size
To stop Eudora from transferring incoming messages that are too large, turn on
the Skip messages over ? K option in the Checking Mail Settings, and specify a
size. Only the first few lines of the messages that exceed that size are transferred,
with a note at the bottom stating that the whole message has not been transferred.

If you decide you want to transfer the whole message, click on the Fetch icon in
the incoming message window, then check mail again.

If you decide you don’t want the message and want to delete it from the server,
use the method above under “Deleting Mail from the Server.”
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Opening a Mailbox
To open a mailbox, select it from the Mailbox menu. To open a mailbox that is
within a folder (referred to as a “nested” mailbox), select the folder in the
Mailbox menu, then select the mailbox from the submenu (or continue selecting
subfolders until the mailbox can be selected).

                           
Opening mailboxes

Opening Other Mailboxes
You can open a mailbox that is located outside the Eudora Folder (on a different
network volume, for example). To do this, make an alias of the mailbox file and
place the alias in the Eudora Folder (in your System Folder) or a subfolder within
the Eudora Folder. Then, start up Eudora and the mailbox will appear on the
Mailbox menu (or a submenu). As long as the alias is in the Eudora Folder or a
subfolder within the Eudora Folder, the mailbox will remain on the Mailbox and
Transfer menus indefinitely, even if you quit and restart Eudora.
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The Anatomy of a Mailbox
Mailbox windows are one of the most important elements of Eudora. They
contain all of your incoming and outgoing message summaries.

A mailbox window

Message Summaries
Each line in a mailbox window represents a message and is called a message
summary. To select one or more message summaries, use one of the following
options:

• To select one summary, click on it.

• To select two summaries and all the summaries between them, click on a
summary, hold down the shift key, and click on another summary.

• To make “disjointed” selections, hold down the command key and click on
summaries.

• To select all the summaries that are from or to the same person, hold down the
option key and click on a summary.

• To select a summary that best matches the letters you type, type the first few
letters of a sender or recipient’s name (or the subject, if this mailbox is
currently sorted by subject).

Each message summary is divided into columns: Status, Priority, Attachments,
Sender/Recipient, Date, Size, and Subject. You can show or hide these columns
using the Mailbox Columns Settings.

A message’s Status and Priority can be changed directly in the mailbox window.
To do this, click on the message summary column you want to change. The
pointer displays as the popup menu symbol ( ). Hold down the mouse button and
select an option from the popup menu.
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You can copy one or more message summaries. To do so, select the summaries
and then select Copy from the Edit menu. The information in each selected
summary is copied. This information can be pasted into a new message or a text
file for recordkeeping or later use.

The Status Column
This column displays the message status, which is one of the following:

• The message has not been read (all mailboxes except Out), or is
queueable/sendable but has not been queued/sent (Out mailbox
only).

<blank> The message has been read (all mailboxes except Out), or is not yet
able to be queued or sent because it has no recipients (Out mailbox
only).

R Reply has been chosen for the message.
F Forward has been chosen for the message.
D Redirect has been chosen for the message.
S The message has been sent (outgoing messages only).
Q The message is queued to be sent (outgoing messages only).
T The message is queued to be sent at a specified time (outgoing

messages only).
- The message was transferred from the Out mailbox before being

sent.

The Priority Column
This column displays the message priority. You can use the popup to set a
particular priority, or to raise or lower the priority.

Highest priority.

High priority.

<blank> Normal priority.

Low priority.

Lowest priority.

Raise Raise the priority one level.

Lower Lower the priority one level.

QUALCOMM Incorporated 61



Working with Mailboxes Eudora User Manual

For more information on message priorities, see the section “Setting the Message
Priority.”

The Attachments Column
This column displays the attachment icon ( ) if a message has attached
documents.

The Sender/Recipient Column
This column shows the sender of the message (for incoming messages) or the
intended recipients (for outgoing messages).

To select all the message summaries from a particular sender or recipient, hold
down the option key and click on one of the message summaries from that person.

Note: Bugs in some POP servers/mail transport systems cause Eudora to
display the sender of incoming messages as ???@???. This is
because the required From: header is missing. If you encounter
such a message, see your e-mail administrator. Administrators can
obtain a copy of qpopper from ftp.eudora.com to correct the
problem (see Appendix A).

The Date Column
This column displays the date and time the message was composed, or, for timed
outgoing messages, the date and time the message is scheduled to be sent. Eudora
uses two methods of displaying date information in mailbox windows,
Age-sensitive and Fixed (this is set in the Date Display Settings). If Age-sensitive
is selected, mail that arrives today has a time stamp, mail that arrived within the
last six calendar days is stamped with the day of the week, and mail that arrived
prior to the previous week is stamped with the date. If Fixed is selected, all mail
messages are stamped with the date and time, with the date formatted according to
the short date format in current use by your Macintosh and the time formatted
according to the current time format.

The Size Column
This column displays the size of the message in K (K = 1024 bytes).

The Subject Column
This column displays the subject of the message. The sender originally typed this
information into the message header, but you can modify it (see the section
“Editing Incoming Messages”).
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Displaying and Resizing Columns
To specify which columns you want to be displayed in your mailboxes, select
Settings... from the Special menu, click on Mailbox Columns and be sure the
columns you want to see are on. You can also turn the separator lines on and off.

To resize a column in a mailbox window, move the mouse pointer until it is over
the dotted column divider to the right of the column you want to resize. The
pointer turns into the column resize cursor ( ).

Simply press the mouse button, drag the divider to the position you desire, and
release the mouse button. The column divider moves to the new location, and the
mailbox is redrawn.

You can only shrink a column as far as its left divider. If you do that, a double
divider line is displayed in place of the column, and its contents are hidden. To
redisplay the column, drag the right divider line to the right.

Using the Mailbox Size Display
In the lower left corner of each mailbox window, three numbers show the size
information for that mailbox. The first is the number of messages in the mailbox;
the second is the total amount of space those messages require; the third is the
amount of disk space that is wasted with the mailbox.

A mailbox with 5 messages that takes up 3K and wastes 4K of disk space

Wasted space is created when messages are deleted from a mailbox. This wasted
space is automatically removed when the amount of wasted space in the mailbox
is greater than the amount of space the messages in the mailbox use, or if the
amount of space wasted in the mailbox is greater than 5% of the free space on the
volume that contains it.

To manually clean up the wasted space in a mailbox, hold down the command key
and click on the mailbox’s size display. Or, to clean up all your mailboxes, hold
down the option and command keys and click on any mailbox size display.
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Creating Mailboxes and Folders
Eudora lets you create mailboxes to put messages in, and folders to put mailboxes
(or more folders) in.

There are three ways to create mailboxes and folders:

• Using the New option from the Mailbox menu and folder submenus.

• Using the Mailboxes window from the Special menu (see the section “Using
the Mailboxes Window”). The Mailboxes window is most useful if you want to
create several mailboxes at one time.

• Using the New option from the Transfer menu (see the section “Transferring
Messages”).

Creating a Mailbox or Folder Using the Mailbox Menu
To create a new mailbox or mail folder, select New... from the Mailbox menu.
The New Mailbox dialog is displayed.

New Mailbox dialog

To create a mailbox, type in the new mailbox name and click OK. The mailbox is
created and added to the Mailbox and Transfer menus.

To create a mail folder, type the name of the new mail folder and check the Make
it a folder option. Click OK to create the folder. The New Mailbox dialog is
displayed again. Type the name of a mailbox to create within the new folder, then
click OK. The new folder and its mailbox are displayed in the Mailbox and
Transfer menus.
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Creating a Mailbox Within a Folder
To create a new mailbox within a particular folder, select that folder from under
the Mailbox menu and choose New... from the submenu that is displayed.

The New Mailbox dialog is displayed. Type in the new mailbox name and click
OK. The mailbox is created and added to the Mailbox and Transfer menus. You
can also create a subfolder—just check the Make it a folder option in the New
Mailbox dialog.

Using the Mailboxes Window
Mailboxes and mail folders provide a structured way for you to organize
messages. The Mailboxes window lets you create new mailboxes and folders,
remove and rename them, and move mailboxes among folders.

To accomplish any of these tasks, select Mailboxes from the Special menu. The
Mailboxes window is displayed.

The Mailboxes window

The Mailboxes window has two identical lists of mailboxes and folders, each
entitled Eudora Folder (or the name of the folder holding your mail—see the
section “Mail Storage” for details). These list the names of the mailboxes and
folders you have created (folders are identified by an arrow to the right of the
name). Each list is similar to that displayed under the Mailbox and Transfer
menus, except that the In, Out, and Trash mailboxes aren’t included.

If the Mailbox window isn’t big enough to display all of your created mailboxes
and folders, use the scroll bar on the right side of either list to view the rest of the
mailboxes and folders.
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Note: Double-clicking on any of the mailboxes in a list opens that
mailbox. Messages can be selected, opened, and otherwise
manipulated from there.

Double-clicking on a folder opens that folder and displays its contents in the list,
and puts the folder name in the title popup.

Opening a mail folder

To move back out of a folder, select another folder from the title popup.

Moving up out of a mail folder
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Creating a New Mailbox or Folder in the Mailboxes Window
To create a new mailbox or folder in the Mailboxes window, be sure one of the
lists is displaying the folder you want to put the new item in. Then click on the
New button below that list. The New Mailbox dialog is displayed requesting the
name of the new mailbox or folder.

Naming a new mailbox

Type in the new name, check the Make it a folder option if you want to, and
click OK. The new mailbox or folder is displayed in the lists, and added to the
Mailbox and Transfer menus.

Renaming a Mailbox or Folder
To rename a mailbox or folder, select the one you want to rename (from either
list) then click on the Rename button under that list. The Rename Mailbox dialog
is displayed requesting the new name. Type in the new name and click Rename to
rename the mailbox or folder.

Renaming a mailbox or folder
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Moving a Mailbox (or Folder) from one Folder to Another
To move a mailbox or folder from one folder to another, select the one you want
to move (from either list). In the other list, open the destination folder so that its
name is displayed above the list. Click on the appropriate Move button to move
your selection to the other folder.

Moving a mailbox, before and after

Removing a Mailbox or Folder
To remove a mailbox or folder, select the ones you want to remove (from either
list) then click on the Remove button under that list. A dialog is displayed asking
you to confirm the removal. Click on the Remove It button to remove the
mailbox. If you selected more than one mailbox or folder, you are prompted for
each one of them. Click on the Remove All button to remove all of them without
further prompts.

If you choose to remove a mailbox in which messages are still stored, or a folder
in which other mailboxes or folders are stored, all the messages, mailboxes, and
folders contained within the selected mailbox or folder are also removed.
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Deleting a Message
As a safeguard against inadvertent deletions, two steps are used to delete a
message from your Macintosh: first you put the message in the Trash, then you
empty the Trash.

To put a message in the Trash, select the message then select Delete from the
Message menu, or select Trash from the Transfer menu, or press the delete key.
The message is transferred to the Trash mailbox.

To delete the messages in the Trash mailbox (removing them permanently from
your Macintosh), select Empty Trash from the Special menu.

To delete a message permanently without sending it to the Trash first, select the
message, hold down the shift and option keys, and select Nuke from the Message
menu (or use any of the deleting options).

Warning:  You cannot undo a Nuke operation!

You can set up Eudora to warn you if you try to delete unread, queued, or unsent
messages. To do this, use the Extra Warnings Settings to turn on those options.

Quitting Eudora empties the contents of the Trash mailbox when the Empty
Trash on Quit option in the Miscellaneous Settings is turned on. Finally, if you
want to delete just a few messages from the Trash mailbox, select them, then
select Delete from the Message menu or press the delete key. Deleting a message
from the Trash removes it completely.

Automatically Deleting Attachments
When you delete messages, you can have their attachments automatically deleted.
To do this, turn on the Trash attachments with messages option in the
Attachments Settings, and be sure the attachments are still in the Attachments
Folder (or the folder you have specified for attachments). If you have this option
on, and want to delete a message but save its attachment, move the attachment
into another folder before deleting the message.
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Transferring Messages
You can transfer messages to any of your mailboxes. There are several ways to do
this: use the Transfer menu, drag a message summary to an open mailbox, or
drag an open message’s Tow Truck to an open mailbox.

To put a copy of a message in another mailbox (instead of transferring the
message), hold down the option key and use one of the transfer options above.
This is useful if you want to file a message in more than one mailbox.

If you try to transfer a message to the Out mailbox, an alert is displayed informing
you that some header information may be removed from the message during
transfer. Click Yes to transfer the message.

Note: You can undo mailbox transfers using the Undo command under
the Edit menu.

Using the Transfer menu
The Transfer menu is one way to transfer messages among your mailboxes. With
a current message open, or message summaries selected, select a mailbox from the
Transfer menu. The messages are transferred from their previous mailbox to the
mailbox you selected.

Dragging Messages
You can drag messages from one mailbox to another using the message
summaries or the Tow Truck icon in an open window.

To drag a message summary to another mailbox, select the message summary (or
summaries), place the cursor over the summary, and hold down the mouse button.
The cross pointer will change to an arrow. Drag the summary into any open
mailbox window. When you release the mouse button, the message is transferred.

To drag an open message to another mailbox, hold down the mouse button over
the Tow Truck icon and drag the message into any open mailbox. When you
release the mouse button, the message is transferred.

Creating a Mailbox or Folder During Transfer
To create a mailbox and transfer the current message into it at the same time,
select New... from the Transfer menu instead of the name of a mailbox. The New
Mailbox dialog is displayed.
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New Mailbox dialog

You can create a new mailbox or mail folder (for details, see the section “Creating
Mailboxes and Folders”). When you are done, the current message is transferred
into the new mailbox.

Filtering Messages
Note: The first time Eudora Light reads in a filter file containing filters

that were created in Eudora Pro, a warning message is displayed
indicating that some of the filters may not work as they did in
Eudora Pro. Since Eudora Light supports only a subset of the
filtering features that Eudora Pro offers, advanced filter actions
will be displayed in the Filters window but not executed. See
“Filter Actions” below for more information.

A number of e-mail management functions in Eudora Light can be done
automatically using filters. For example, you can transfer all the messages from
your children into a Personal mailbox, and raise the priority of all the messages
from your customers to Highest Priority.

To open the Filters window, select Filters from the Special menu. The Filters
window is displayed, and any filters you have created are listed on the left.
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The Filters window with an example filter

To create or modify a filter, first click on the New button or select an existing
filter.

Second, select the options for how you want the filter to be used: as an automatic
filter to be invoked on any Incoming and/or Outgoing mail, and as a Manual
filter that can be invoked when you select Filter Messages from the Special
menu. Any combination of these options works.

Third, define the criteria for the filter: use the header item popups and the text
fields to specify which header items should include a particular string of text. You
can define two related terms for the criteria so that your filter is as specific as
possible (see the section “Filter Criteria”).

Fourth, define the action to be taken on messages that fit the criteria (see the
section “Filter Actions”) and save the filters.

When the filters are invoked (automatically or manually), each message is
matched against each filter, and messages that meet a filter’s criteria are acted on
as specified until a Transfer To or Skip Rest action is done. At that point, the
next message is filtered.
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Note: Filters are automatically named based on the criteria for the filter.
They are invoked in order from top to bottom, and you can re-
order them by dragging a filter up or down in the list.

To print your filters, open the Filters window and select Print from the File
menu. The standard Print dialog is displayed so that you can make your print
selections.

You can change the width of the filters list to create more or less space for your
list. To do this, put the arrow over the black line to the right of the list and drag
the line to the left or right.

Filter Criteria (the Match Area)
Each filter can use one or two “terms” as its criteria, connecting them as
appropriate with the conjunction popup.

Use the Header field to specify which message header items you want the filter to
search. You can select an option from the popup menu or enter one yourself (this
is helpful if you want to search for a header item that does not appear on the
menu, such as X-Priority). The selections are as follows:

• To

• Cc

• From

• Subject

• Reply-To

• «Any Recipient»

• «Any Header»

• «Body»

The «Any Recipient» option searches all possible recipient items (To, Cc, Bcc);
the «Any Header» option searches all message headers (including hidden headers
that are shown with the BLAH BLAH BLAH option); and the «Body» option
searches the message body.

Use the Match Type popup to control how the header item is matched with the
text string in the text field. The match options are:
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contains or does not contain
If the specified header item contains or does not contain the text string, filter the
message.

is or is not
If the specified header item is or is not a complete match of the text string, filter
the message.

starts with or ends with
If the specified header item starts with or ends with the text string, filter the
message. The starts with item refers to the first non-whitespace character after
the colon, so any spaces after the colon are ignored.

appears or does not appear
If the header item appears or does not appear in the message, filter the message
(the text field is ignored). This is useful for filtering messages based only on the
types of fields they contain.

intersects nickname
If the text string is included in a nickname (whether it is a full address or a
nickname within the nickname), filter the message.

Use the Text fields to specify the text strings that the filter is searching for.

Note: It is recommended that the contents of this field be kept as specific
and brief as possible. The greater the complexity, the less the
likelihood of a match.

Note: Do not enter a header label in the Text field as part of the text
string (e.g., “To:,” “From:,” “Bcc:”). For example, to filter all
messages from “Justine,” do not enter “From: Justine” in the Text
field. Rather, select “From:” in the Header field, and enter simply
“Justine” in the Text field (choosing, for example, “contains” from
the Match Type popup). Another example:

Sample Match Area in Filters window
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Use the Conjunction popup to link the two terms. The conjunction options are:

ignore
Ignore the second term; if the message matches the first term, filter the message.

and
If the message matches both the first and second terms, filter it.

or
If the message matches either term, filter it.

unless
If the message matches the first term but not the second term, filter it; if the
message matches the first term and the second term, do not filter it. (This lets you
exclude certain variations of the first term.)

Filter Actions
All messages that match the filter criteria are acted on as specified with the
Actions popups. Each filter can do up to five things to a message that matches the
criteria. You can use the same action twice if it does not directly affect the
original message (for example, Copy To can be used twice, but not Transfer To).

The Actions options are as follows:

Note: Actions appended with “(PRO Only)” and greyed out on the
Actions popup menus are available in Eudora Pro but not in
Eudora Light. Filters created in Eudora Pro are displayed in
Eudora Light, and those actions that are not “PRO Only” will
work in Eudora Light. Although “PRO Only” actions will not work
in Eudora Light, their information is preserved, so that they will
work if you go back to Eudora Pro. Brief descriptions of the “PRO
Only” actions are given below, in italics.

None
No action.

Make Status (PRO Only)
In Eudora Pro, assigns the selected status to messages.

Make Priority
Assigns the selected priority level to messages. If you select a set level, messages
are set to that priority. If you select Raise or Lower, messages are raised or
lowered one priority level based on their pre-filter level.

Make Label (PRO Only)
In Eudora Pro, assigns the selected label to messages.
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Make Subject
Assigns the new subject to messages. If you choose this option, the entire subject
of the message is replaced with the new subject. Use the “&” symbol if you want
to add the new subject to the old subject. For example, entering New Subject:&
results in New Subject:Old Subject.

Play Sound (PRO Only)
In Eudora Pro, plays the selected sound when messages are received.

Open (PRO Only)
In Eudora Pro, opens the Mailbox and/or Message when a message is received.

Print (PRO Only)
In Eudora Pro, prints one copy of each message.

Notify User (PRO Only)
In Eudora Pro, notifies you As normal and/or In report when messages are
received.

Forward To (PRO Only)
In Eudora Pro, forwards messages to the e-mail address given.

Redirect To (PRO Only)
In Eudora Pro, redirects messages to the e-mail address given.

Reply With (PRO Only)
In Eudora Pro, replies to messages with the selected stationery message.

Server Options (PRO Only)
In Eudora Pro, sets the message’s server action to Fetch and/or Delete.

Copy To
Copies messages to the selected mailbox.

Transfer To
Transfers messages to the selected mailbox.

Skip Rest
Stops filtering for the message (the message is not matched to the rest of the
filters in the filter list).

The Last used field displays the date the filter was last used on a message. This
helps you identify filters that are no longer useful and can safely be deleted.
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Sorting Messages Within Mailboxes
The message summaries in mailboxes are automatically sorted by date, in
ascending order (the newest messages at the bottom of the mailbox). To change
this, select the appropriate command from the Sort submenu from the Special
menu.

The Sort submenu

This sorting method is “sticky,” meaning that each sort is based on the previous
state of the mailbox. For example, if a mailbox is sorted by date, and then you sort
by sender, the messages are grouped by sender and each group is in order by date.

You can change this by holding down the shift key and sorting by another
column. The original sort remains intact, but it is now grouped with the new
selection. For example, if the mailbox is sorted by sender with each group of
messages in order by date, and then you hold down the shift key and sort by size,
the messages are still grouped by sender but the groups are now in order by size.

To sort in descending order, hold down the option key and select a sort option.

To keep messages with the same subject together all the time, select the Group
Subjects option from the Sort submenu. If this is checked, messages with the
same subject are kept together in the mailbox regardless of whether you sort by
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date, sender, etc. A bullet next to the Subject column heading tells you that the
Group Subjects option is active.

Sticky sorting places an underline under the column heading for the sorted
column. To remove this underline (and turn off the sticky sort), repeat the sort for
the same column. Incoming mail that arrives in a mailbox with an underlined
column heading is automatically sorted by that column (subject to the restrictions
above). For example, if a mailbox is sorted by sender and a new message comes
in from Justine, it will be grouped with other messages from Justine.

To always put just-arrived mail at the bottom of your mailbox, be sure the Date
column heading is not underlined. To sort by date and time, be sure Date is
underlined. For example, a message dated yesterday at 10:00am arrived today at
11:00pm. If Date is underlined, that message is way back in your mailbox with
yesterday morning’s mail.

Note: Sometimes sorting by Date can be incorrect. This usually happens
if the messages have incorrectly formatted date fields, or unknown
or incorrect time zones.

Finding Text Within Messages
You can find a word or a string of text anywhere in your Eudora messages, your
Address Book, or your Filters. To do this, select Find from the Special menu, and
Find... from the submenu. The Find dialog is displayed.

The Find dialog with an example search

Enter the word or string of text that you want to find in the Find field. Or, if you
don’t want to type in the text, you can highlight the text in an existing message,
then select Enter Selection from the Find submenu. The selected text is
automatically inserted in the Find field of the Find dialog.

If you need to specify how the text should appear, use the Whole word and
Match case options:
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Whole word
If this option is on, the text is found only if it appears by itself and is not part of
another word. For example, if the text is “info” then the word “information” will
be passed over.

Match case
If this option is on, exact matches of the text are found, taking the capitalization
into account.

When the Find field is filled in and the appropriate options are set, you can use
one of two functions to find the text: Find and Search. Use the Find option to
find instances of the text in just the current open message, or use any of the
Search options to find instances of the text by searching mailboxes or mail
folders.

Finding Text in the Current Open Message
To find text in the current message, verify that the Find field and options are
filled in correctly, then click Find (or select the Find Again command from the
Find submenu) to find the text.

Eudora begins looking for the text at the insertion point (where the cursor is) in
the message. If a match is found, the matching text is highlighted in the open
message. If no match is found, the not found alert is displayed.

To find the next occurrence of the text in the current message, click Find in the
Find dialog, or select the Find Again command from the Find submenu.

To stop Eudora while it is looking for text, hold down the command key and type
a period (.).

Searching for Text in Messages, Mailboxes, and Folders
To search for text in a certain mailbox or mail folder, first verify that the Find
field and options are filled in correctly. Then use the Starting field to specify
where you want the search to start.

Your folders and mailboxes are searched in order as they appear in your Mailbox
menu, and your messages are searched in order as they appear in your mailboxes.
The display area tells you where you are in that order using the following format:
Folder:Mailbox:Message headers (if a mailbox is directly under the Eudora
Folder, the folder name is not shown).

To change where you are in your mailboxes and messages, you can use the arrows
in the Starting field or the Choose... button:
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Go to the first mailbox that has messages in it, and to the first message in
that mailbox.

Go back to the previous mailbox that has messages in it, and to the first
message in that mailbox.

Go back one message, regardless of what mailbox it is in.

Go forward one message, regardless of what mailbox it is in.

Go forward to the next mailbox that has messages in it, and to the first
message in that mailbox.

Use the Choose... button to select a mailbox from the Mailbox menu and go to
the top of the mailbox you selected.

Once you’ve specified where the search should start, you can specify how to
search:

Summaries only
If this is checked, only the sender and subject fields of message summaries are
searched. The search is much faster when this option is checked.

Search Mailbox
Search all messages in the mailbox shown in the display area.

Search Mailfolder
Search all messages in the folder shown in the display area (even if there are
multiple mailboxes).

Search To End
Start at the message shown in the display area and search the rest of the messages
in the current and subsequent mailboxes.

If a match is found, the appropriate message is opened and the matching text is
highlighted. Select any of the Search options to search for other instances of the
text (or use the Find option to find more instances in just the current open
message).

To stop Eudora from continuing a search, click on the Stop button in the progress
window, or hold down the command key and type a period (.).
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Saving a Message to a File
You can save a message to a separate text file on your Macintosh. To do this,
open or select the messages you want to save to text. Then, select Save As... from
the File menu. The Save As dialog is displayed allowing you to choose a name
and location for the file.

The Save As dialog

Enter the name you want to give the text file, and select the appropriate options.

Guess Paragraphs removes extraneous carriage returns from the message,
leaving returns only at the ends of paragraphs, and converts multiple spaces into
tabs.

Include Headers retains each message’s header information in the saved
document. If this is not checked, only the body of the messages is saved.

Once you’ve made all of your choices, click on the Save button in the dialog.

Note: If an unread (•) message is saved to a file, its status changes to
read, regardless of whether the message was opened.

If you select multiple messages from a mailbox window and select Save As..., all
of the messages are saved to a single file.
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Choosing an Application for Saved Messages
When you save a message to a file using the Save As... command, the new text
file is formatted as basic ASCII text in a Macintosh document. The document type
is determined by the program you select using the TEXT files belong to option in
the Attachments Settings.

To do this, select Settings... from the Special menu. The Settings dialog is
displayed. Then, select the Attachments Settings. Near the bottom of the dialog,
click the TEXT files belong to button. A standard file dialog is displayed. Using
this dialog, search through your disk to locate the desired application (probably
your favorite word processing program). Select the application and then click
Open. The selected application is displayed in the button.

The desired application is now selected
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Using the Address Book
The Address Book is where you keep information about individuals or groups that
you correspond with. Each entry in the Address Book includes a nickname for a
person or group, their full e-mail addresses, a real name, and any notes. You can
also use the Address Book to put nicknames on the Quick Recipient List, and to
address a new message.

To open your Address Book, select Address Book from the Special menu.

The Address Book with example entries
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All of the Address Book entries are kept in the Eudora Nicknames file. To show
the entries in this file, click on the arrow to the left of the file. When the arrow
points down, all the entries for the file (all nicknames) are displayed.

You can use the View By option to display the entries using any of the fields
except the Notes field. For example, if you want to view the entries by nicknames,
select View By Nickname. If you view by a field that doesn’t contain any data,
the entry is displayed with «».

You can find and select an entry by typing the first few letters of the entry. The
list of entries must be active (to make the list active, click once somewhere in the
list).

You can page up and down in the list of entries, use the arrow keys to move up
and down through the entries, or hold down the command key and use the arrow
keys to move from top to bottom of the list and to open and close the list.

You can also resize the Address Book sections using the dividers between them.
Put your cursor over a line, and drag the line where you want it. This lets you hide
or display fields.

Resizing the Address Book sections

To print your Address Book entries, select the entries you want and select Print
from the File menu. The standard Print dialog is displayed.

Creating New Entries
To create a new Address Book entry, click on New. A dialog is displayed asking
what you want to call it.
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Creating a new Address Book entry

Enter a Nickname for the entry. A Nickname (sometimes called an alias) is an
easily remembered, shorter substitute for the e-mail addresses in the entry.
Nicknames can be used in place of proper e-mail addresses in the To, Cc, and Bcc
fields of outgoing messages.

Select the Put it on the recipient list option if you want the nickname on your
recipient list. Click on OK to create the entry. Then you can enter the information
for that entry.

In the Address(es) field, enter the complete e-mail addresses of the people (or
person) to be included in the nickname, separating the addresses with commas or
returns (this is the only place you can use a return to separate addresses). You can
also use nicknames in this field, but be sure that any nicknames you use are
defined in their own entry. You can use a mix of nicknames and complete e-mail
addresses.

Note: Be sure there is no other information in this field except addresses
or nicknames, or your messages will be addressed incorrectly.

In the Name field, enter the real name of the person or group. If there is just one
address for the entry, the real name and the address is included in the To field for
your recipient to see. If there is more than one address for the entry, the real name
is the only thing included in the To field for your recipients—they do not see the
whole list of recipients.

In the Notes field, you can enter any notes to yourself. This information is not
included in outgoing messages.

It is recommended that you have at most 2,000 nicknames in the Eudora
Nicknames file. If the file is too large, it may appear collapsed in the Address
Book, but you can still use all the nicknames when addressing messages. If you
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have a large number of entries, you may want to consider using a Ph server (for
information, see Appendix A).

To save your changes to the Address Book, select Save from the File menu.

Changing and Removing Entries
To make changes to an Address Book entry, select the entry from the list and edit
the fields as appropriate.

Important: If you change a nickname, be sure to correct any entries
that reference that nickname.

To remove an entry, select it from the list and click on the Remove button. You
cannot remove the Eudora Nicknames file.

To save your changes, select Save from the File menu.

Including Nicknames on the Quick Recipient List
To include a nickname on the Quick Recipient List, select the appropriate Address
Book entry from the list and click on the Recipient List option (next to the
Nickname field). The nickname for the selected entry is included on the Quick
Recipient List. If you change a nickname or remove an entry, the Quick Recipient
List is updated as appropriate. For details about using the Quick Recipient List,
see the section “Using the Quick Recipient List.”

Note: You can add multiple nicknames to the Quick Recipient List by
selecting multiple entries. Hold down the shift key to select
multiple entries in sequence, or the command key to make disjoint
selections.

To save your changes, select Save from the File menu.

Addressing a Message from the Address Book
You can open and address a new message from the Address Book using the To,
Cc, and Bcc buttons, or by dragging one or more entries to an open message.

To create a new message from the Address Book, select the entry to which you
want to address the mail (hold down the shift key to select multiple entries in
sequence, or the command key to make disjoint selections). Then click on To, Cc,
or Bcc. A new composition window is displayed with the selected nickname(s)
inserted in the appropriate field.

86 QUALCOMM Incorporated



Eudora User Manual Using the Address Book and Quick Recipient List

Note: You can also double-click on one entry to enter that nickname in
the To field, or double-click on one of many selected entries to
enter those nicknames in the To field.

Once the composition window is displayed, you can use the To, Cc, and Bcc
buttons to insert additional nicknames into the corresponding fields. Or, you can
drag the appropriate entries to those fields: Click once on an entry, then drag it to
the appropriate field, or double-click an entry to add it to the To field. (If you drag
an entry, the full e-mail address is inserted instead of the nickname.)

Note: If you hold the shift key down when using the To, Cc, and Bcc
buttons, the Address Book remains current (topmost).

The “Make Address Book Entry” Command
The Make Address Book Entry command is used to create entries in your
Address Book, and is especially helpful for making group entries. You can use
this command from anywhere in Eudora, including the Address Book, mailboxes,
open messages, and the Directory Services window.

From anywhere in Eudora you can highlight the addresses you want, then hold
down the shift key and select Make Address Book Entry From Selection from
the Special menu. The New Nickname dialog is displayed prompting you for the
nickname of the new entry. The new entry’s Address(es) field will include all of
the addresses that you selected.

Note: If the new nickname has the same name as an existing nickname, a
prompt is displayed asking if you want to add the selected names to
the existing nickname or replace the existing nickname with the
new selection.

In the Address Book, highlight several different entries (hold down the shift key
to select multiple entries in sequence, or the command key to make disjoint
selections), then select Make Address Book Entry... from the Special menu. The
New Nickname dialog is displayed prompting you for the nickname of the new
entry. The Address(es) field of the new entry will include the nicknames for the
entries you selected, not the real addresses.
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Using the “Make Address Book Entry” command from the Address Book

In a mailbox, highlight the message(s) you want and select Make Address Book
Entry... from the Special menu. The New Nickname dialog is displayed
prompting you for the nickname of the new entry. Follow the instructions for
creating a new entry. If the current message is an outgoing message, the new entry
will include all of the addresses in the To, Cc, and Bcc fields. If the current
message is an incoming message, the new entry will include the address in the
From field. If multiple messages are current (i.e., you have several message
summaries selected in a mailbox window), addresses are taken from each message
and are all put in the new entry.

Note: The Make Address Book Entry command uses the Replying
Settings. If the Reply to all By Default setting is turned on (or you
hold down the option key), the new entry will include all of the
recipients of the messages plus the sender. Or, if the Include
yourself setting is turned off, your address is not included in the
new entry.

In the Directory Services window, finish a Ph query and select Make Address
Book Entry... from the Special menu. The New Nickname dialog is displayed so
that you can name the nickname. The real name and e-mail address are included
in the new entry.

88 QUALCOMM Incorporated



Eudora User Manual Using the Address Book and Quick Recipient List

The “Finish Address Book Entry” Command
With the Finish Address Book Entry command, you can enter a unique portion
of a nickname in the To, Cc, or Bcc fields of a message, then select Finish
Address Book Entry from the Edit menu, and the nickname will be completed
for you. You must enter the characters in the nickname that make it unique, or
Eudora will not know which nickname to use. For example, if you have two
nicknames, joan and john, you would have to enter “joa” or “joh” for Eudora to
complete them.

To insert the real addresses for the entry, instead of the nickname, hold down the
option key and select Finish & Expand Address Book Entry from the Edit
menu.

Using Nicknames that were Not Created by Eudora
To use a nickname file that was not created in Eudora, remove the Eudora
Nicknames file from your Eudora Folder (in your System Folder), put the new file
in its place, renaming it to Eudora Nicknames, and be sure the format of the file is
correct: One nickname on each line with the word “alias,” a space, the nickname,
a space, and the real addresses separated by commas. For example,

alias joe joe@wow.com
alias group joe@wow.com,lisa@wow.com,bill@wow.com

You will need to quit and re-open Eudora to see your new entries in the Address
Book.

Saving Your Entries to a File
To save your Address Book entries as a text clipping with tab-delimited entries,
select the entries you want and hold down the option key while dragging them to
the finder. To save them as a text clipping with the standard nickname format, use
the same process but do not hold down the option key.

Using the Quick Recipient List
The Quick Recipient List is your list of often-used nicknames. If you have
checked the Recipient List option in an Address Book entry, the entry’s
nickname is included in the list.
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The Recipient List option

To open a new message addressed to someone on your Quick Recipient List,
select New Message To, Forward To, or Redirect To from the Message menu,
and select the nickname from the displayed list.

To insert a nickname into a message that you have already opened, put the cursor
where you want the nickname and select Insert Recipient from the Edit menu.

To insert the real address(es), instead of the nickname, hold down the option key
and select Insert & Expand Recipient from the Edit menu.

More than one nickname from the Quick Recipient List can be added to the To,
Cc, and Bcc fields of any message. If you use the Insert Recipient command,
commas are added where necessary.
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Opening Directory Services
Eudora can access two different directory services, Ph and Finger. To use these
services, you must put the name of the host machines for the Ph and finger servers
in the Hosts Settings.

To use the directory services, select Directory Services from the Special menu.
The active Ph or finger server (defined in your Hosts Settings) is displayed above
the query field. Or, you can select a string of text (presumably someone’s name),
hold down the shift key, and select Directory Services from the Special menu.
This opens the window and inserts the string of text into the query field.

Using Ph
To look someone up using Ph, enter your query and click on Ph. The query is sent
to your Ph server, and the response is displayed in the lower section of the
window.

A Ph query and its response

Note: You can type any Ph command in the query field, except login
commands or commands requiring login. For information about
the Ph server source code, see Appendix A.
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If the “Live” Ph queries option is on in your Hosts Settings, the connection with
your server is kept open and Ph queries are automatically sent to the server when
you finish typing the query text.

Note: To add the results of your Ph query to your Address Book, select
Make Address Book Entry from the Special menu (for details on
how to use this command, see the section “The ‘Make Address
Book Entry’ Command”). This may not work if your Ph server is
not set up for it.

Finding Ph Servers
Some Ph servers keep a list of other Ph servers that are available on the Internet.
This is not always a comprehensive list of every Ph server out there, but it can be
helpful.

To get the list of servers from the active server (the active server is displayed
above the query field), click on the globe in the Directory Services window (next
to the Ph button). A list of servers is displayed in the results area. To go to one of
those servers and do a query, hold down the command key and click on the
server’s URL, or just double-click on the URL.

Using Finger
To use the Finger protocol, enter your query and click Finger. The query should
be in the form “name@domain.” If you omit the “@domain” segment, the host
name displayed above the query field is used (this is the SMTP host from your
Hosts Settings). The finger query is sent to the finger server, and the response is
displayed in the lower section of the window.

A Finger query and its response
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Addressing a Message from the Directory Services Window
To address a message with the query results in the Directory Services window,
open a new message (or make an existing message active), open the Directory
Services window, do the Ph or Finger query, then select the e-mail address from
the results and drag it into the appropriate field of the outgoing message.
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Extended Messaging Services
The Extended Messaging Services Application Programming Interface (EMSAPI)
lets you plug other software into Eudora. For example, you could use language
conversion software to translate a message to another language, security software
to automatically secure a message, or compression software to compress a
message and its attachments.

To make plug-in software available to Eudora, put the software in the Eudora
Stuff folder contained in your Eudora Light Application Folder, then restart
Eudora. Some plug-in software items show up in the Extended Services submenu
in the Edit menu, others show up as icons in message windows.

For information about available plug-in software, send e-mail to
<quest-rep@eudora.com> or visit the World Wide Web site
<http://www.eudora.com>.

Printing
You can print the current message or messages, a plain text window, selected text
within a message or text window, the contents of the Directory Services window,
and your filters, signatures, and Address Book entries. Eudora automatically
prints headers and footers on each page, giving the window title, page number,
and your return address.

To print the current message or item, select Print... from the File menu.

To print just the selected text, hold down the shift key and select Print Selection
from the File menu.

To print one copy and bypass the standard Print dialog, select Print One Copy.

Putting Multiple Users on One Macintosh
You can set up Eudora so that more than one user can be on a single Macintosh.
This also works if you have multiple e-mail accounts, or want to store your mail
in a folder other than your System Folder.
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To do this, for each user make a copy of the Eudora Folder that resides in the
System Folder. The copies can be named whatever the users want, and put
anywhere they want, including on a floppy disk or network volume.

Each user can open Eudora by double-clicking on the Eudora Settings file within
their assigned folder. They can make changes to the Settings, create new
mailboxes, nicknames, and filters, etc., and not affect other users on the
Macintosh.

Note: To give users easy access to their mail, you can create aliases for
their Eudora Settings files and put them wherever you want on the
Macintosh (the Apple Menu Items folder is a good option).

Troubleshooting
Occasionally, you may encounter a problem or bug when using Eudora (as
indicated by an error message or some other type of symptom).

Make sure that you have the current maintenance release of Eudora. To do this,
first locate the Eudora application in your Eudora Light Application Folder. Click
once on the application to highlight it, and select Get Info from the Finder File
menu. Look for the Eudora version number in the dialog, and make a note of this
number (a lowercase “L” in the version number stands for “Light”). Next, using
your World Wide Web browser, go to the Eudora Web site,
<http://www.eudora.com>, and check to see what the latest version of Eudora is.
If that version is later than the one you have, download it and install it as
described in the “Getting Started” section. This may solve the problem or bug
you’ve encountered.

If you do have the latest version of the Eudora software, check the current
README file for potential known conflicts. The README may also contain
suggestions on how to resolve some of these problems.

The following troubleshooting table provides the corrective action for some of the
most common error messages or symptoms.
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Symptom Corrective Action

Eudora displays the following error
when you try to send or queue
mail:

“There has been an error
transferring your mail. I said:
DATA and then the SMTP server
said: 503 Need RCPT
(recipient)”

Either the message you are trying to send,
or the first message queued in your Out
mailbox, has one of these two problems:
(1) It doesn’t have anything in the To: or
Bcc: field, or (2) All it has in the To: or
Bcc: field is a nickname that doesn’t point
to an address. An example of the second
problem is to have the word Mickey in
the To: field and to have a nickname entry
for Mickey in your Address Book but no
address associated with that nickname.

Eudora displays the following alert
when you try to launch the
program:

“Memory is tight. You may need
to close some windows, clean up
your In, Out, and Trash
mailboxes, or increase Eudora’s
memory size”

Mail stored in Eudora’s In, Out, Trash,
and any open mailboxes increases the
amount of memory Eudora needs to
operate (mail stored in other mailboxes
does not). If you have a large amount of
mail in these mailboxes, try transferring
them to other mailboxes to decrease
Eudora’s memory requirements. If that
does not stop the alert from appearing,
increase Eudora’s memory size from the
Finder: First, quit Eudora. Then, highlight
the Eudora application icon, select Get
Info from the File menu, and increase the
Preferred Size for the application.

Eudora displays the following alert
when you try to launch the
program:

“Eudora cannot continue. Error
opening your settings file.”

If this happens, Eudora automatically
switches to your backup settings file
“Eudora Settings.bkup.” Quit Eudora and
open it again. If the problem is not
resolved, you must throw away the
“Eudora Settings” and “Eudora
Settings.bkup” files, as they are not
repairable. When you start Eudora again,
a new Eudora Settings file will be created
for you and you will need to reconfigure
Eudora.
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Symptom Corrective Action

Eudora displays the following error
when you try to check mail:

“-ERR Maildrop lock busy”

This usually happens after your
Macintosh has “hung” during a mail
check and you are now attempting to re-
connect to the mail server. Try checking
your mail again in ten minutes. If the
problem persists, the best thing to do is to
contact your e-mail administrator and tell
them that you have a POPper process that
needs to be disconnected.

Note: If you are a System Administrator,
you might also want to try the
QUALCOMM popper. It has a timeout
that will reset the mailbox if the
connection closes abnormally. You can
ftp it anonymously from ftp.eudora.com in
the quest/unix/servers/popper directory.

Eudora displays the following error
when you try to check mail:

“There has been an error
transferring your mail. I said:
PASS and then the POP server
said: -ERR Password supplied
for “<username>” is incorrect.”

First, verify the correct spelling of your
POP account in the Settings dialog
(Getting Started). Make sure the account
address is complete, paying particular
attention to the part of the address before
the ‘@’ symbol, and ensuring throughout
the address that uppercase and lowercase
letters are entered correctly. Second,
verify that you are entering your
password correctly (make sure the caps
lock key is off). Contact your e-mail
administrator if the problem persists.
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Symptom Corrective Action

Eudora displays the following alert:

“Mailbox <mailboxname> has a
damaged table of contents. Shall
I build a new one?”

If a table of contents file for a particular
mailbox should become corrupt for one
reason or another, Eudora will not be able
to open the mailbox until it is rebuilt. If
this happens to you more than once with a
given mailbox, quit Eudora, then check
your Eudora Folder (in your System
Folder) for a .toc file for that mailbox,
and if you have such a file, delete it. You
will not lose any mail, though you will
lose the status information for the
messages. If the problem persists, you
may want to have your Macintosh
checked for possible problems.

Eudora displays the following error
message when you try to check
mail:

“Connection came up halfway
then failed.”

This message indicates that TCP/IP did its
“half” to open the connection, but the
other end didn’t respond. Although it
could indicate a network problem, it
usually indicates that your mail server
does not support POP3 or that your POP3
server is not currently available. You
should contact your e-mail administrator
and inquire about the status of the POP3
service if the problem persists.

Eudora displays the following error
message when you try to check or
send mail:

“A TCPClose command was
already issued, so there is no
more data to send on this
connection.”

This is a problem with your SMTP or
POP3 server. It is dying shortly after
startup. Contact your e-mail administrator
if the problem persists.
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Symptom Corrective Action

Random display problems. Rebuild your desktop: While holding
down the command and option keys,
restart your Macintosh, and continue to
hold down the command and option keys
until an alert appears asking if you’re sure
you want to rebuild the desktop file on
your hard drive. Click OK (you can
release the command and option keys at
this point). If this doesn’t help, you may
want to have your Macintosh checked for
possible problems.

Correspondents are complaining
that lines in the messages you send
are not wrapping correctly (lines
are broken in funny places).

The best solution is to turn on the Word
wrap option in the Settings dialog
(Sending Mail) and only press return
when you want to start a new paragraph.
Eudora will take care of breaking your
paragraphs into lines.

Your mail server complains that
you do not have a Date header in
your mail.

Eudora will not put a Date header on your
mail if you haven’t set the correct time
zone information on your Macintosh. You
can set the time zone using the Map
control panel, or, if you have System 7
Pro or System 7.5, the Date & Time
control panel. Remember to change your
time zone for Daylight Savings Time so
that Eudora can set the Date header
correctly.

You received a message containing
columns and the columns are not
lining up correctly

Your screen font is probably a
proportional font. Change your display
font to a non-proportional font (such as
Courier) in the Settings dialog (Fonts &
Display).
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The Settings Dialog
The Settings dialog lets you specify how you want to use Eudora. To display the
Settings dialog, select Settings... from the Special menu.

The Settings dialog contains many categories, which are described below. The
default setting for each option is listed in brackets after the name of the option.

Note: For your convenience, some options appear in more than one
category. For example, your real name appears in both the Getting
Started and Personal Information Settings. Changing a setting in
one group changes the setting in all groups.

Getting Started
The Getting Started Settings determine the minimum user information necessary
to send and receive mail.

The Getting Started Settings
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POP account [none]
This is the address for your account on the POP server. Enter your login, an “@”
sign, and the full domain name of the computer. For example, if your assigned
login is “justine,” and the name of the computer where you receive e-mail is
“pop3.qualcomm.com” type “justine@pop3.qualcomm.com” in this field.

Note: Your POP account may or may not be the same as your e-mail
address. If your e-mail address differs from your POP account
(suppose, in this example, Justine’s e-mail address is
“justine@qualcomm.com”), then put the e-mail address in the
Return address field of the Personal Information Settings.

Note: If you use UUCP as your mail transport, see Appendix F.

Real name [none]
The text you enter here (generally your first and last name) is included in the
From field of outgoing mail.

Connection method [TCP/IP]
This specifies how you are connecting to the network. If you are using Eudora via
TCP/IP software (e.g., a direct network connection, SLIP, or PPP), select
TCP/IP. If you are using Eudora without TCP/IP software, select
Communications Toolbox (meaning you are using the Communications Toolbox
software for communications). If you don’t want Eudora to attempt to make any
connections, select Offline. (With Offline on, Eudora does not attempt to make
automatic mail checks and warns you when you attempt to make manual mail
checks.)
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Personal Information
The Personal Information Settings determine your personal identity on the POP
and mail servers, for incoming and outgoing mail.

The Personal Information Settings

POP account [none]
This is the address for your account on the POP server.

Real name [none]
The information you put in this field (generally your first and last name) is
included in the From field of outgoing mail.

Return address [none]
This is your e-mail address. It is included in the From field of outgoing messages,
and when a recipient replies, this address is used. Your POP account is used if you
do not enter an address here.

Note: If you do enter an address in this field, first test the address to be
sure that mail sent to it is indeed delivered to you. If you use an
invalid return address, no one will be able reply to your mail.

Dialup username [none]
This is your dialup username. If you use Eudora with the Communications
Toolbox, and you have a secondary user name for use during the dialup process,
enter it here (e.g., your login name on a terminal server). See Appendix D for
details regarding how this field can be used.
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Hosts
The Hosts Settings determine what servers to use, and how to use them.

The Hosts Settings

POP account [none]
This is the address for your account on the POP server.

SMTP [none]
This is the name of your SMTP server. If the computer that your POP account is
on also runs an SMTP server, you can leave this field blank.

Note: If you use UUCP as your mail transport, see Appendix F.

Ph [none]
This is the name of your Ph server. It is necessary for doing Ph queries in the
Directory Services window.

Finger [none]
This is the name of your finger server. If you leave this blank, Eudora uses your
SMTP server as your finger server.

DNS load balancing [off]
If this is on, the workload of a community of Eudora users is spread over several
host computers. Turn this on if your network administrator tells you to.

DNS Load Balancing works by making Eudora choose a random address from the
list of addresses returned by the DNS (without DNS load balancing, Eudora will
always choose the first address from the list). If you have several machines that
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can perform the exact same service, list all their IP addresses under one domain
name, then instruct your users to use that domain name and to turn on DNS Load
Balancing. Now the users are equally likely to use any one of the “balanced”
machines for the service.

Overlap POP3 commands for better performance [off]
If this is on, commands are sent immediately to your server, instead of waiting for
a previous command to be completed. This is faster, but your POP server may not
be able to handle it.

Live Ph queries [off]
If this is on, the connection with your server is kept open with the Directory
Services window. Ph queries are automatically sent to the server when you finish
typing the query text.

Checking Mail
The Checking Mail Settings determine how Eudora checks for and receives your
incoming mail messages.

The Checking Mail Settings

POP account [none]
This is the address for your account on the POP server.

Check for mail every ? minutes [off, none]
If this is on and you enter a number, Eudora automatically checks your POP
server for new mail at regular intervals and transfers to your Macintosh any mail
addressed to you. The number you enter specifies the number of minutes between
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checks. It’s a good idea to set this at no less than 15 minutes. Checking mail more
frequently puts an unnecessary drain on your POP server. This option only works
when Eudora is running. Leaving this field empty disables automatic checking
(even if the box is checked).

Don’t check when using battery [off]
If this is on and your Macintosh is running on battery power, mail is not
automatically checked (even if you have the check mail option on).

Skip messages over ? K [off, 40]
If this is on, messages over the specified size are downloaded only in part. These
messages include the first few lines, and a statement that says the message is not
complete. This can be useful on slow connections. For details, see the section
“Managing Your Mail on the POP Server.”

Leave on server for ? days [off, none]
If this is on, Eudora copies incoming messages to your Macintosh and leaves the
message on the POP server for the specified number of days. If you leave it blank,
your mail is left on the server indefinitely. For details, see the section “Managing
Your Mail on the POP Server.”

Send on check [on]
If this is on, any messages that are queued in the Out mailbox are sent when mail
is checked (automatically or manually).

Save password [off]
If this is on, your password is remembered even if you quit and restart Eudora, so
you’ll never be prompted to enter it. Only use this option if your Macintosh is in a
secure place.

Delete from server when emptied from trash [off]
If this is on, any messages that are deleted from your Trash mailbox are also
deleted from the POP server. For details, see the section “Managing Your Mail on
the POP Server.”

Overlap POP3 commands for better performance [off]
If this is on, commands are sent immediately to your server, instead of waiting for
a previous command to be completed. This is faster, but your POP server may not
be able to handle it.

Authentication [Passwords]
This specifies which authentication technology to use: Passwords, Kerberos, or
APOP. Ask your e-mail administrator which one to use.
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Sending Mail
The Sending Mail Settings determine how Eudora sends your outgoing mail
messages.

The Sending Mail Settings

Return address [none]
This is your e-mail address.

Domain to add to unqualified names [none]
This is the domain name that Eudora automatically adds to an unqualified name.
An unqualified name is a name that doesn’t have an “@” sign followed by a
domain name. This can be used to save time when addressing large numbers of
messages to users in the same domain.

SMTP Server [none]
This is the name of your SMTP server. If the computer that your POP account is
on also runs an SMTP server, you can leave this field blank.

Immediate send [on]
If this is on, the rightmost button in the icon bar of the message composition
window is labeled Send. Clicking on this button immediately sends the message
to the SMTP server. If this option is off, the button is labeled Queue and clicking
on it places the message in the Out mailbox marked ready for delivery (Q).

Send on check [on]
If this is on, any messages that are queued in the Out mailbox are sent when mail
is checked (automatically or manually).
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Use signature [on]
If this is on, Eudora automatically attaches your Standard signature (if you have
one) to the end of outgoing messages.

May use Quoted-Printable [on]
If this is on, Eudora uses quoted-printable encoding when necessary, such as
when sending messages that contain long lines of text or special characters. If this
option is off, quoted-printable encoding is never used. We recommend that you
leave this option on.

Keep copies of outgoing mail [off]
If this is on, a copy of each message you send is kept in the Out mailbox. If this
option is off, outgoing messages are put in the Trash mailbox after they are sent.

Word wrap [on]
If this is on, a carriage return is not required at the end of each line of type in an
outgoing message. Eudora automatically wraps text to the next line, with line
breaks at roughly 76 characters per line. This makes your mail more legible to
recipients using line-oriented mail systems. It is strongly recommended that you
leave this option on.

Fix curly quotes [on]
If this is on, Eudora replaces all “curly” quotation marks in message text or
attachments with "conventional" quotation marks prior to sending the message. It
also replaces bullets (•) and en/em dashes (–/—). These marks are special
characters, and this option allows messages to be sent without using quoted-
printable encoding.

Note: If your recipients have MIME, there’s no reason to use this option.
Only turn it on if most of the people you correspond with don’t use
MIME.
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Attachments
The Attachments Settings determine how Eudora sends and receives attachments.

The Attachments Settings

Encoding method [BinHex]
This specifies what Encoding Method to use for attached documents. To change
the method for just the current message, use the Attachment Type popup in the
outgoing message window. For details, see the section “Attaching a File to a
Message.”

Always include Macintosh information [off]
If this is on, Macintosh resources and types are included in attachments if they are
basic MIME types. It may be advisable to turn this off when sending attachments
to non-Macintosh users. For more information, see the section “Attaching a File
to a Message,” and also see Appendix G.

Attachment Folder [none]
This specifies what folder to put incoming attachments into. To specify a folder,
single-click on the folder name button. A dialog is displayed prompting you to
select a folder.
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Trash attachments with messages [off]
If this option is on, Eudora automatically deletes an attachment received with a
message when that message is deleted. The attachment must still be in the folder
defined as the Attachment Folder. If you want to save an attachment but delete the
message, move the attachment to another folder or turn this option off.

TEXT files belong to [TeachText]
This specifies what application is used to open text files. When you choose Save
As... from the File menu, Eudora creates a Macintosh document that is saved for
the application named in this field. That way, when you double-click the saved
file, this application is used to open it. You may want to set this option to your
favorite word processing program. To change the application, single-click on the
application name button (the default is TeachText). A dialog is displayed allowing
you to select an application.

Fonts & Display
The Fonts & Display Settings determine how Eudora displays windows and text.

The Fonts & Display Settings

Screen Font, Size, and Text Color [Mishawaka, 9, black]
These options specify the font, size, and color to be used for text displayed in
Eudora messages and mailbox windows. Select the color using the Macintosh
color wheel.
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Background Color [white]
This specifies a background color to be used in Eudora messages and mailbox
windows. Select the color using the Macintosh color wheel.

Print Font and Size [Courier, none]
The Print Font popup menu lets you select a font to be used when you print
messages using the Print command. Enter a size in the box.

Message window width [80]
This specifies the width of new and received message windows (in characters). If
you leave this field blank, the default value is 80. This setting has no effect on
what your mail looks like when it is sent. When mail is sent, Eudora wraps at or
before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based
on the width of the “0” character.

Message window height [none]
This specifies the height of new and received message windows (in lines). If you
leave this field blank, the default value is 20.

Note: If the Zoom windows when opening option is turned on, received
messages’ window heights are automatically adjusted to the length
of the message text.

Zoom windows when opening [on]
If this is on, new mailbox and message windows automatically open to their
“zoomed” size. The zoomed size is computed on a window-by-window basis. For
mailbox windows, zoomed size is just wide enough to display the widest
summary, and just long enough to display all the summaries (but no longer than
the Macintosh display screen). For message windows, zoomed size is just long
enough to display all of the message (but no longer than the Macintosh display
screen), and as wide as the Message window width setting. Composition windows
zoom to the height specified by the Message window height setting.

Waste cycles drawing trendy 3D junk [on]
If this is on, interface items are displayed in 3D.
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Date Display
The Date Display Settings determine how the date is displayed in message
summaries.

The Date Display Settings

Date formats [Age-sensitive]
This specifies how to display the date. If Age-sensitive is selected, messages
dated today are displayed with the time, messages dated within the last six
calendar days are displayed with the day of the week, and messages dated 7
calendar days or more ago are displayed with the date. If Fixed is selected, all
messages are displayed with the time and date.

Display dates using [Sender’s timezone]
This specifies what time zone to use. If Local timezone is selected, messages are
displayed with your time and date. If Sender’s timezone is selected, messages are
displayed with the sender’s time and date.
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Getting Attention
The Getting Attention Settings determine what Eudora does when it is running in
the background and wants your attention, or when new mail arrives.

The Getting Attention Settings

Use an alert [on]
If this is on, an alert dialog notifies you when new mail is received.

Flash an icon in the menu bar [on]
If this is on, an icon is flashed in the menu bar when Eudora needs attention.
Eudora uses two different icons—a Mail flag when you have new mail and an
envelope with an exclamation point in it for everything else.

The new mail and attention icons

Open mailbox (new mail only) [on]
If this is on, mailboxes are automatically opened when new mail arrives in them,
and the first unread message of the last unread batch of messages is selected.

Play a sound [on]
If this is on, a sound is played when Eudora needs attention. There are two
different sounds, the New mail sound (played when new mail arrives) and the
Attention sound (played for everything else). Popup menus next to these titles let
you select the sound you want from the available sounds on your Macintosh.
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Say OK to alerts after 2 minutes [on]
If this is on, any alerts that announce a problem sending and receiving mail
automatically go away after two minutes. Many network problems are temporary,
so this allows Eudora to try the communication again. This is most useful if you
have automatic mail checking enabled.

Note: Turning this option on may cause some Communications Toolbox
connection tools to give you less progress information.

Extra Warnings
The Extra Warnings Settings determine if you are warned before making a
possible mistake. Most of the warnings are displayed with an option to stop that
warning from being displayed again. If you chose that option, you can turn the
warning back on using the Extra Warnings Settings.

The Extra Warnings Settings

Try to delete unread mail [on]
If this is on, you are warned if you try to delete unread mail.

Try to delete queued mail [on]
If this is on, you are warned if you try to delete queued mail.

Try to delete any unsent messages [on]
If this is on, you are warned if you try to delete unsent messages.

Try to queue a message with no subject [off]
If this is on, you are warned if you try to queue a message with no subject.
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Try to quit with messages queued to be sent [on]
If this is on, you are warned if you try to quit Eudora and you have queued
messages.

Try to send a message whose size is more than ? K [on, 900]
If this is on, you are warned if you try to send a message whose size is more than
the specified number. This number must be between 0 and 1000000.

Set a changed message back to read-only [on]
If this is on, you are warned if you try to make an edited incoming message
uneditable.

Empty the Trash mailbox [on]
If this is on, you are warned if you try to empty the Trash mailbox. Once
messages are deleted from the Trash, they are completely gone.

Try something that requires too much memory [on]
If this is on, you are warned if you try to do something that might take more
memory than you have available.

Replying
The Replying Settings determine how replies are created.

The Replying Settings

Reply to all [When option key is down]
This specifies which recipients to include in a reply. Reply to all By default
creates a reply addressed to the sender and all the recipients of the original
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message. You can hold down the option key to create a reply to only the sender.
Reply to all When option key is down creates a reply addressed to only the
sender. You can hold down the option key to create a reply addressed to the
sender and all the recipients of the original message.

When replying to all [off]
This specifies how to address a reply. If Include yourself is on, when you Reply
to all (as described above) your address is left in the address list of the new
message and you receive a copy of your own reply. If this option is off, your
address is removed from the reply message and you do not receive a copy of the
reply. If Put original To: recipients in Cc: field, not To: field is on, the
addresses of the original message recipients are moved from the To field to the Cc
field of the reply to all message. Only the address of the original sender is placed
in the To field.

Note: To determine who you are for the Include yourself option, Eudora
uses the “me” nickname, if you create one for yourself. If you do
not have a “me” nickname, Eudora uses the contents of the POP
account and Return address fields from the Personal Information
Settings.

Copy original’s priority to reply [on]
If this is on, your replies use the same priority as the original message.

116 QUALCOMM Incorporated



Eudora User Manual Reference

MacSLIP Cooperation
The MacSLIP Cooperation Settings determine what Eudora does when you are
connecting to your service provider using MacSLIP From Hyde Park Software.
Normally, when Eudora or any other application tries to make a connection,
MacSLIP will automatically dial your provider and establish a connection. This
connection remains open until you close it or a timeout period elapses. The
settings below modify this behavior.

The MacSLIP Cooperation Settings

Don’t make automatic checks when MacSLIP is not already connected [off]
If this is on, automatic mail checks are not done unless your MacSLIP connection
is currently running (this avoids unnecessary connections to your service
provider).

Disconnect MacSLIP if Eudora connected it [on]
If this is on, MacSLIP disconnects at the end of a mail check when it was
connected by Eudora, but it does not disconnect at the end of a mail check when it
was connected by another application. If this option is off, MacSLIP will not
automatically disconnect at the end of a mail check, even if it was connected by
Eudora. Use this option to minimize the time you are connected to your service
provider.

Moving Around
The Moving Around Settings determine how you open messages and switch fields
in Eudora.
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The Moving Around Settings

Arrow+these modifiers to switch messages [Command]
If any of these are on and there is a message window open, you can hold down all
of the keys you have selected and use the Macintosh keyboard arrows to close the
current message and open the next or previous message in the mailbox. The up
and left arrow keys open the previous message; the down and right arrow keys
open the next message. The arrow keys can be used by themselves to move the
insertion point in messages.

After transferring or deleting or paging past end of current message, open
[Next unread message]
This specifies whether to automatically open the next message after you delete or
transfer the current message. Nothing means nothing is opened. Next message
means the next message in the mailbox is always opened. Next unread message
means the next unread message in the mailbox is always opened.

Tab to switch fields, option-tab to insert tab [off]
If this is on and your cursor is in the body of a message, the tab key moves the
cursor to the To field, and the option and tab keys together insert a tab at the
insertion point. If this option is off, the tab key inserts a tab, and the option and
tab keys together move the cursor to the To field.

Return switches among header fields [on]
If this is on, the return key moves the cursor to the next header field in outgoing
messages. If this is off, the return key inserts a carriage return into outgoing
message headers.
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Miscellaneous
The Miscellaneous Settings determine assorted Eudora functions that do not
neatly fit into other settings categories.

The Miscellaneous Settings

Close messages with mailbox [off]
If this is on, closing any mailbox window (except Out) closes all the open
messages from that mailbox.

Empty Trash on Quit [on]
If this is on, the Trash mailbox is emptied when you quit Eudora. If this is off, the
Trash is only emptied when you select Empty Trash from the Special menu.

Turbo redirect by default [off]
If this is on and you select Turbo Redirect To, a redirected message is created
with the specified recipient, the message is queued, and the original message is
deleted. You can hold down the option key to do a regular Redirect.

Re-sort mailboxes less often [off]
If this option is on, mailboxes are only sorted when they are opened or mail is
added to them.

Lock whole program in memory [off]
If this is on, the whole program is loaded into memory and kept there until you
select Quit. This takes more memory, but runs a little faster. This option is only
for 68k versions.
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Use old-style “.toc” files [off]
If this is on, each mailbox stores its table of contents in a “mailbox.toc” file,
instead of in its resource fork (the default in 3.0 and future versions of Eudora). If
you have upgraded to version 3.0, this is automatically on. You should turn this
off at some point so that your mailboxes convert to using resource forks.

With this option, each mailbox is converted as it is used. To convert your
mailboxes all at once (either to .toc files or to resource forks), use the TOC
converters provided with Eudora. The TOC README file explains the
differences between the two formats and how to use the TOC converters.

Convert Hesiod names to lower-case [on]
If this is on, Hesiod results are converted to lower-case, except for user names.

Note: Hesiod, developed at MIT under Project Athena, is server software
that furnishes to Eudora the name of your mail server. Hesiod is
used at very few sites.

Write to Internet Config [off]
If this is on, preferences are written to Internet Config. Internet Config is not
supported, so this is not recommended.

Read from Internet Config (not recommended) [off]
If this is on, preferences are read from Internet Config. Internet Config is not
supported, so this is not recommended.

Correct (but slow) international sorting [off]
If this is on, slower but internationally correct string comparisons are used.

Require control key for text/message dragging [off]
If this is on, you can only drag items when the control key is down.

Generate filter reports [off]
If this is on, a filter report is generated when messages are filtered from the In
mailbox.
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Settings Icons
The Settings Icons Settings determine the display of category names and icons in
the Settings dialog.

The Settings Icons Settings

Styled Text
The Styled Text Settings determine when to use style information in incoming
messages.

The Styled Text Settings
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When receiving styles, pay attention to [Bold, Italic, Underline, Font, Size, Color,
Left/right/center, Margins, Excerpts]
If any of these options are on, that style is displayed in your incoming messages
(if the sender allows it). “Excerpts” refers to excerpt bars included at the left of
quoted text containing styles.

Mailbox Columns
The Mailbox Columns Settings determine which columns are displayed in
mailbox windows.

The Mailbox Columns Settings

Show columns [Status, Priority, Attachments, Who, Date, Size]
If any of these options are on, that column is displayed in mailbox windows. The
Subject is always displayed.

Draw separator lines [on]
If this is on, separator lines are drawn in mailbox windows.
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Menu Commands
File
This menu provides basic file and mail functions.

New Text Document
Create a new text file.

Open...
Open a selected (highlighted) message summary, a text file,
or a Eudora Settings file.

Open Selection
Open a selected (highlighted) message summary, an
attachment, a URL, or a mailbox (from the Mailboxes
window).

Close
[option] Close All
Close the current window.
Close all windows.

Save
[option] Save All
Save the changes to the topmost window.
Save the changes to all open windows.

Save As...
Save the current message(s) to a plain text file.

Send Queued Messages
Send all messages that have been queued for delivery.

Check Mail
Pick up new mail from the POP server.

Page Setup...
Set printing options.

Print...
[shift] Print Selection...
Print the current message(s), or window.
Print just the selected text.
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Print One Copy
Print one copy of the selection (bypass the Print dialog).

Quit
Quit the Eudora application.

Edit
This menu provides text editing tools.

Undo
Reverse the last action taken.

Cut
Delete the selected text and place it on the clipboard.

Copy
[option] Copy & Unwrap
[shift] Copy Without Styles
[option]-[shift] Copy Without Styles & Unwrap
Copy the selected text and place it on the clipboard.
Copy it without carriage returns.
Copy it without the text styles.
Copy it without text styles or carriage returns.

Paste
Paste the contents of the clipboard. Style information is
removed.

Paste as Quotation
Paste the contents of the clipboard as quoted text. Style
information is removed.

Clear
Delete the selected text.

Select All
Select the entire contents of a message or a mailbox.

Wrap Selection
[option] Unwrap Selection
Insert carriage returns into the selection, as appropriate.
Remove the carriage returns from the selection.
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Finish Address Book Entry
[option] Finish & Expand Address Book Entry
Complete the partial text of a nickname.
Complete it and expand it to its real address.

Insert Recipient
[option] Insert & Expand Recipient
Insert the chosen nickname.
Insert the real address of the nickname.

Extended Services submenu
Use Extended Messaging Services.

Mailbox
This menu lets you open a mailbox, or bring an open mailbox to the front.

In
Open the mailbox where incoming messages are stored until
deleted or transferred to another mailbox.

Out
Open the mailbox where messages you compose are stored,
where queued messages are held until actually sent, and
where copies of sent messages may be initially stored.

Trash
Open the mailbox where deleted messages are stored.

New...
Display the New Mailbox dialog to create a new mailbox.

[Your Mailboxes]
Open the selected mailbox that you have created.
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Message
This menu lets you create, send, and delete messages.

New Message
Open a new message composition window.

Reply or Reply To All
[option] Reply To All or Reply
[shift] Reply Quoting Selection or Reply Quoting
      Selection To All
[option]-[shift] Reply Quoting Selection To All or
      Reply Quoting Selection
Reply to the sender of the current message.
Reply to the sender and all the original recipients.
Reply and quote only the selected text from the sender.
Reply to all and quote only the selected text from the sender.
(Based on the Reply to all option in the Replying Settings.)

Forward
Forward the current message to someone else.

Redirect
Forward the current message to someone else, but make the
return address be the person who originally sent the message.

Send Again
Resend a message rejected by the mail system. Be sure to fix
whatever caused the problem before you queue the message.

New Message To
Send a message to someone on the Quick Recipient List.

Forward To
Forward a message to someone on the Quick Recipient List.
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Redirect To or Turbo Redirect To
[option] Turbo Redirect To or Redirect To
[shift] Redirect To or Turbo Redirect Without Delete To
[option]-[shift] Turbo Redirect Without Delete To or
      Redirect To
Redirect the message to someone on the Quick Recipient List.
Redirect it, queue it, and delete the original message.
Redirect it, queue it, and keep the original message.
(Based on the Turbo redirect by default option in the
Miscellaneous Settings.)

Send Message Now or Queue Message
[option] Change Queueing...
Send the message immediately, or queue the message in the
Out mailbox.
Display the Change Queueing dialog.

Attach Document...
Attach a file to the current message.

Change submenu
Change the queueing, status, or priority of a message.

Delete
[option]-[shift] Nuke
Transfer the current message into the Trash mailbox.
Delete the current message permanently. (Warning: There is
no way to undo a Nuke operation.)
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Transfer
This menu lets you transfer the current message(s) to another mailbox.

In
Transfer the current message(s) to the In mailbox.

Out
Transfer the current message(s) to the Out mailbox.

Trash
Transfer the current message(s) to the Trash mailbox.

New...
Display the New Mailbox dialog to create a new mailbox,
then transfer the current message(s) into that mailbox.

[Your Mailboxes]
Transfer the current message(s) to the selected mailbox that
you have created.

Special
This menu lets you use additional Eudora functions.

Filter Messages
Run the manual filters for the current message(s).

Make Address Book Entry...
[shift] Make Address Book Entry From Selection...
Create an Address Book entry (nickname) from the current
message.
Create an entry from the selected addresses.

Find submenu
Search for the designated character string within a message,
messages, or mailboxes.

Sort submenu
[option] Sort Descending submenu
Sort the message summaries in a mailbox in ascending order.
Sort them in descending order.
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Filters
Display the Filters window.

Mailboxes
Display the Mailboxes window.

Address Book
Display the Address Book window.

Directory Services
Display the Directory Services window.

Settings...
Display the Settings dialog.

Communications...
Display the Communications Toolbox settings (not needed
when using TCP/IP—see the Getting Started Settings).

Signatures submenu
Display the Standard or Alternate signature windows.

Change Password...
Change your password on the POP server.

Forget Password
Make Eudora forget your password so mail can’t be checked.

Empty Trash
Delete all messages from the Trash mailbox.

Window
This menu lets you work with Eudora windows.

Send to Back
Send the topmost (current) window to the back of all
displayed windows.

[Eudora Windows]
Bring the selected window to the front of all displayed
windows.
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The Eudora Folder
The first time you start Eudora, it creates a Eudora Folder within your System
Folder. Even though you do not need to access the Eudora Folder during normal
operation, this section is provided to show you where Eudora stores your
mailboxes and messages.

Eudora Filters
Filters are saved in the Eudora Filters file.

Eudora Log
Mail transfers and errors are logged in the Eudora Log file. When the file reaches
100k in size, it is saved as Old Log (replacing any existing Old Log file) and a
new Eudora Log file is created.

Eudora Nicknames
Address Book entries are saved in the Eudora Nicknames file.

Eudora Settings
Settings information is saved in the Eudora Settings file.

Signature Folder
Signatures (Signature and Alternate) are kept in the Signature Folder.

Spool Folder
The Spool Folder is used to store attachments created especially for Eudora. This
can occur, for example, if you drag a file from a StuffIt™ archive directly into a
Eudora composition window.

In, Out, and Trash
Mail is saved in the In, Out, and Trash mailbox files. Mailboxes that you create
are also saved in files like these. These files are in Unix spool format.

Mailbox Aliases
Eudora supports the use of aliases for mailboxes that, for some reason, you have
moved to a location outside the Eudora Folder. This allows you to use these
mailboxes from within Eudora. Place the mailbox aliases in the Eudora Folder or
a subfolder within the Eudora Folder.
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The Eudora Light Application Folder
During the installation, the Eudora Light folder is installed on your hard drive in
the location you specify. This folder contains the following:

• Eudora Light, the Eudora Light application.
• Eudora Stuff, the folder to use for EMSAPI and resource plug-ins that you

want available in Eudora.
• Extras, the Extras folder.
• ObjectSupportLib, a system library used by Eudora running on a Power

Macintosh.
• README, the text file with important information and instructions that are not

provided in this manual.

Extras
The Extras folder contains the following items:

• Dialup, the folder with files to be used for direct serial dialup.

• Plugins, the folder with various Eudora plug-ins.

Dialup
The Dialup folder contains the following:

• Direct UNIX Navs, a plug-in file for direct UNIX dialups.

• README, the Dialup folder README text file.

• srialpop.shar, a program for use on UNIX systems to ensure that Eudora
can transfer mail.

• GV Modem Definitions, Apple Modem Tool 1.5 settings for all current
Global Village Modem products.

• Connection Tools, the Connection Tools folder containing the Apple
Modem and Serial Tools for the Communications Toolbox (see the section
“Installing Connection Tools”).

• Internet Service Providers, plug-in files for accessing service providers. To
use a Eudora plug-in file, drag it into your Eudora Stuff folder, or into your
Preferences Folder or your Eudora Folder (both are located inside your
System Folder), and then start Eudora.
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Plugins
To use a Eudora plug-in file, drag it into your Eudora Stuff folder, or into your
Preferences Folder or your Eudora Folder (both are located inside your System
Folder), and then start Eudora.

The Plugins folder contains the following:

• README, the Plugins folder README text file.

• Esoteric Settings, a plug-in file that adds extra settings screens to the
Eudora Settings dialog. Only recommended for use by the most advanced
users.

• EudoraTables, a plug-in file for use with the Eudora transliteration function
(see Appendix E).

• Forward934, a plug-in file that makes Eudora do RFC 934-style
forwarding.

• Kerberos Settings, a plug-in file that adds the settings necessary for using
Kerberos with Eudora. Consult with your Kerberos administrator prior to
using this file.

• Synch I/O, a plug-in file that turns on synchronous I/O, which can improve
compatibility with problem extensions and disk drivers.

• Toshiba, a plug-in file for use with a certain model of Toshiba PowerBook
hard drives, to prevent the drives from corrupting Eudora mailboxes.
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Anonymous ftp (ftp.eudora.com)
QUALCOMM’s Eudora Division has an anonymous ftp server (ftp.eudora.com)
that has information and software related to Eudora. These are located within the
“quest” directory. Included are POP3, Ph, and password changing servers, the
srialpop program, current product information, dialup files, and more.

Eudora Information
The information in this manual was correct at the time of printing. However,
things happen very quickly in the electronic world, meaning that some of this
information may already be out of date. For the very latest information about
Eudora, send e-mail to eudora-info@eudora.com.

Obtaining a POP Server
If you would like to run a POP server on your own UNIX system, we suggest you
use “popper.” Popper is available via anonymous ftp from ftp.eudora.com. Popper
versions are available for a number of UNIX systems.

VAX/VMS systems may try the “Multinet” package from TGV, or IUPOP3,
available via anonymous ftp from ftp.indiana.edu.

Ph Server Source Code
A server for the “Ph” protocol is available via anonymous ftp from
ftp.eudora.com.

Password Change Server
Three sample UNIX servers for Eudora’s Change Password... command are
available via anonymous ftp from ftp.eudora.com.

QUALCOMM Incorporated 133



Appendix A – Sources Eudora User Manual

Kerberos
To learn more about the Kerberos authentication system that is supported in this
version of Eudora, anonymous ftp to athena-dist.mit.edu and begin in the
pub/kerberos subdirectory.
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Modifiers
Many operations in Eudora can be implemented by holding down one or more
“modifier” keys. Eudora uses the shift, option, command, and control keys as
modifiers.

If you use a modifier key while you pull down a Eudora menu, the menu shows
the modified commands. For a description of each command and its
modifications, see the section “Menu Commands.”

The following list shows modifiers that are not reflected in Eudora’s menus.

shift + Open Eudora Open Eudora but do not check for mail, even if
a mail checking interval is set.

shift + Delete/Transfer Do not open the next message after deleting or
transferring the current message.

shift + Sort Resort within the current sort.

shift + To: /Cc: /Bcc: From the Address Book, do not bring the
composition window to the front after inserting
the nickname.

shift + Directory Services Open Directory Services with the selected text
in the query field.

option + Forward Forward the message without using quote
characters.

option + Queue/Send Open the Change Queueing dialog.

option + double-click URL Display a file dialog to select an application to
use for that URL type.

control + command + click Attachment
Open the folder on your Macintosh that holds
the attachment, and highlight the attachment.

option + Notify Sender Remove the request but do not notify the sender.
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option + Transfer Put a copy of the current message in the selected
mailbox and leave the original where it is.

command + click on mailbox size display
Compact the current mailbox.

option + command + click on mailbox size display
Compact all mailboxes.

option + close window Close all open Eudora windows.

shift + Print Print the current selection.

shift + Make Address Book Entry...
Make an Address Book entry (nickname) from
the current selection.

Shortcuts
The keyboard shortcuts for Eudora functions are as follows:

command + . Stop the current action

command + 0 Open Out mailbox

command + 1 Open In mailbox

command + - Send queued messages

command + = Enter selection into Find window

command + \ Move current window to the back

command + ' Paste as quotation

command + , Finish address book entry (nickname)

command + ; Search again

command + [ Lower priority

command + ] Raise priority

command + A Select all

command + C Copy

command + D Delete
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command + E Send or Queue message

command + F Find window (search for message)

command + G Find again

command + H Attach document

command + J Filter messages

command + K Make address book entry (nickname)

command + L Address Book

command + M Check mail

command + N New message

command + O Open file

command + P Print

command + Q Quit

command + R Reply

command + S Save

command + V Paste

command + W Close window

command + X Cut

command + Y Directory Services

command + Z Undo

arrows Move from one message to another in a mailbox
(depends on your Moving Around Settings).

return, or enter Select the outlined button in any dialog, alert, or
window, or open the selected messages.

space Open a selected message summary or close the current
message and open the next message. For long
messages, scroll the message down one page.

esc Stop any operation currently in progress.
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help Turn Balloon Help on or off.

F1 Undo.

F2 Cut.

F3 Copy.

F4 Paste.

home Scroll the window to the beginning.

end Scroll the window to the end.

page up, page down Scroll up or down through the window.
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Introduction
Eudora uses Simple Mail Transfer Protocol (SMTP) to transfer your outgoing
mail to your SMTP server machine, which in turn uses SMTP to send your mail to
the world at large. Mail from the world at large arrives on your Post Office
Protocol (POP) server, where it waits for Eudora to pick it up with POP version 3.
The mail Eudora sends and receives is constructed in accordance with RFC 822
and RFC 1521 (MIME).

Your Macintosh POP/SMTP
Server

The World at Large

POP
Check Mail

SMTP
Send Queued Messages

SM
TP

Eudora mail transport overview
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Outgoing Mail
When you send an e-mail message to someone, Eudora uses SMTP to send the
mail to your local SMTP server computer. That computer then sends the mail to
your addressee’s computer, also (usually) by means of the SMTP protocol.

Why doesn’t Eudora talk directly to your addressee’s computer? For one thing, it
would take a lot longer for your mail to leave your Macintosh, because your
Macintosh would have to call up each addressee’s computer and deliver your
mail. For another, some computers are “hard to find”; it’s much better to let
another computer “hunt” for your addressee than to make your Macintosh do it.
Finally, sometimes your addressee’s computers won’t be available when you want
to send mail. The SMTP server handles this by holding your mail until the other
computer is ready to accept it, eliminating the inconvenience of having unsent
messages hanging around on your Macintosh.

Incoming Mail
When somebody sends you mail, other computers use the SMTP protocol to
deliver the mail to your POP server. Your POP server puts mail in your “mail
drop,” where it stays until the Eudora program picks it up. When you check your
mail, Eudora uses POP version 3 to pick up your mail and move it to your
Macintosh.

Why doesn’t Eudora use SMTP to receive your mail? SMTP works best when the
computers it knows about are always ready for mail. Unless you wanted to run
Eudora and your Macintosh 24 hours per day, seven days a week, SMTP wouldn’t
work very well for you. It also doesn’t work well in lab environments, where you
might use any number of different Macintoshes.

More Information
If you want to know more about the Internet in general, consult the book
Internetworking with TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN
0-13-470154-2 025.

If you want to know more about SMTP, RFC 822, POP version 3, and MIME, the
official standards are:

RFC 821, “Simple Mail Transfer Protocol,” by Jonathan B. Postel

RFC 822, “Standard for the Format of Internet Text Messages,” by Dave Crocker

RFC 1225, “Post Office Protocol, Version 3,” by Marshall Rose
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RFC 1341, “Multipurpose Internet Mail Extensions,” by Ned Freed and Nathaniel
Borenstein

You can find the RFCs by anonymous ftp to nic.ddn.mil; see Internetworking with
TCP/IP for details.
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Introduction
Eudora is designed for use with MacTCP or for dialup to Cisco terminal servers.
It can be used with other dialup connections as well. Complicated setups are
likely to be unreliable, but if the setup commands to connect are simple, Eudora
works well.

These instructions assume you are familiar with ResEdit, your communications
equipment, and your hosts. It is suggested that one person make these changes to
Eudora and then redistribute the customized version to other users at your site.

Macintosh Requirements
To use Eudora over a dialup connection, you must have the Communications
Toolbox installed. System 7 has it built in.

Dialup Requirements
Eudora needs a “transparent” connection to your POP, SMTP, and (optionally) Ph
servers. Transparent means primarily two things:

1. Characters Eudora sends should not be echoed back to Eudora. Most
systems do echo characters, so something special may need to be done to
achieve this.

2. You must pay close attention to how carriage returns are treated. UNIX
systems routinely translate carriage returns into linefeeds; you must either
disable this on your system or teach Eudora how to deal with it.

Navigation
Eudora has a very rudimentary scripting system built in. This capability is called
“navigation” to separate it from the rather sophisticated connotations of
“scripting.”

Eudora uses a list of strings that it sends out the serial port one at a time. After
each string, it waits until there is no output from the remote system for 2 seconds
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or until a given string is matched, after which Eudora continues with the next
string.

There can be three sets of navigation strings contained in STR# resources: one is
used when connecting (Navigate In), one is used when disconnecting (Navigate
Out), and one is used when switching from SMTP to POP (Navigate Mid). You
can use ResEdit to manipulate these resources. Any of the resources can be
absent, in which case Eudora skips the navigation it would otherwise have done
with that resource.

For each function, Eudora selects an appropriate resource in the following
manner. First, it takes the name of the connection tool currently in use (e.g.,
“Apple Modem Tool”); then, it appends a space and the current type of navigation
(e.g., “Navigate In”). Eudora looks for an STR# resource with that name (e.g.,
“Apple Modem Tool Navigate In”). If that is not found, Eudora looks for an
STR# resource named after the navigation type (e.g., “Navigate In”). Finally, it
looks for specific resource ids (2400 for Navigate In, 2600 for Navigate Out, and
4200 for Navigate Mid). The first STR# resource found is the only one used.

Navigation resources can be in the Eudora application itself, in your Eudora
Settings file, or in a resource plug-in file. The latter is a file with type “rsrc” and
creator “CSOm” placed in your Preferences folder; use of a plug-in file is highly
recommended.

Plug-In files go in the Preferences folder

Special Sequences in Navigation Resources
Eudora provides a set of special character sequences for use in Navigation
resources. These sequences are all two characters long, the first character being a
backslash. Either they are replaced with items from your Eudora Settings, or they
modify the Navigation process.
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Replacements
These special characters are replaced with strings. They can appear at any place in
a navigation string.

\u POP account user name.

\h POP account host name.

\p POP account password.

\s SMTP server host name.

\U Dialin user name.

\P Dialin password.

\n A linefeed (ASCII 10).

\r A carriage return (ASCII 13).

\\ A single backslash character.

\^ Enter a prompt for the \a modifier.

\a Ask the user for something.

\c Cancel if a string appears.

When \^ appears, all the text after it (up until the end of the string or the next ‘\’)
goes into a prompt string that will be used with the \a modifier.

When \a appears, a dialog will be used to ask the user to type something. What the
user types will be used where the ‘\a’ appears.

Example: \^Enter the SecureId code below:\a\r

This will put up a dialog with the prompt “Enter the SecureId code below:”, and
then wait for the user to type in the code. The code will then be sent, along with a
carriage return.

\c is used to enter text that will abort the navigation process. The text is valid only
for the duration of the particular string it appears in. If you wish to look for it in
another string, you must specify it again.

Example: \P\r\eaccepted\cdenied
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Eudora will send the dialin password and a return, then wait until it sees either
“accepted” (in which case the navigation process will continue) or “denied”
(which will abort the navigation process and the mail transfer).

Modifiers
\b Hide from Progress window.

\D Delay.

\B Break.

\e Expect something.

\b – When this appears as the first character in a given string, Eudora won’t print
the string in the Progress window when it is sent. This is useful for passwords or
other state secrets.

\D – Should be the first character in the string and followed only by digits or an
expect string. The digits are taken as a number of seconds to delay (e.g., “\D2” is
a two-second delay). As with other strings, Eudora will wait for output to stop for
two seconds, or for an expect string, before proceeding.

\B – Should be the first character in the string and followed only by digits or an
expect string. The digits are taken as the number of ticks (60ths of a second) to
send a break signal (e.g., “\B30” is a half-second break). As with other strings,
Eudora waits for output to stop for two seconds, or for an expect string, before
proceeding.

\e – Makes Eudora expect to see a specific string in the output from the dialup
server. Eudora sends whatever comes before the \e, and then waits for whatever
comes after it to occur in the data sent from the host. There are two caveats to this.
First, Eudora only matches on the first 7 bits; the high bit of each character is
ignored for matching. This is needed for systems that use parity. Second, Eudora’s
matching is fast and sloppy; highly repetitive data streams and long expect strings
might fool it (for example, Eudora wouldn’t see “Login:” if your server said:
“LogLogin:”).

Eudora follows its normal time-out process when looking for an expect string.
That is, after 45 seconds Eudora asks you if you want to keep waiting or cancel
the process. If you cancel, the connection process is stopped.

If you use either of the password replacement sequences (“\p” for your POP
account password or “\P” for your dialup password) in the same string as an
expect, Eudora assumes the password is wrong if the expect string isn’t found.
This causes Eudora to ask for your password the next time it tries to connect.
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Connecting to Servers
Once the navigation is done, Eudora issues a command to connect to the proper
port of the server you are using. Once this command is sent, the connection must
be transparent, as discussed above; no echoes and no carriage return translation.
Eudora comes configured to send the command

telnet hostname portnumber /stream<return>

The “<return>” means a carriage return in this document only; you must type
actual carriage returns in ResEdit. A template for the command is kept in 7400.13
(“7400.13” is shorthand for STR# resource id 7400, string 13). The template
begins life as “telnet %p %d /stream\n”. The %p is replaced with the hostname
and the %d with the port number. It is acceptable to change this string however
you please, except that %d, if it is used, must come after %p. The best way to
change this string is not to modify it, but to override it. You can do this by
creating an “STR” resource of id 7413 and putting the string you want Eudora to
use in that.

A Return By Any Other Name
When Eudora is communicating with your POP or SMTP server, it’s important
that they agree on what constitutes a line. The Internet specification stipulates that
a line ends with a carriage return followed by a linefeed. Most UNIX systems will
“helpfully” translate carriage returns into linefeeds. If you can’t get that feature
turned off, it may help to make Eudora send only a carriage return, and not the
carriage return/linefeed pair. You can edit 6000.17 to be what you want Eudora to
send at the end of a line. The best way to change this string is not to modify it, but
to override it. You can do this by creating an “STR” resource of id 6017 and
putting the string you want Eudora to use in that.

An Example: Direct Connection To A UNIX Machine
Here’s a suggested connection method if your Macintosh has a serial line to a
UNIX machine, or if there are modems on your Macintosh and UNIX machine.

1. Install the srialpop program on your UNIX system. Source to this is part
of the Eudora distribution.

2. Put the following strings in the “Navigate In” resource.

1: \r\r\eogin:

2: \u\r\essword:
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3: \p\r\r\r\e%

4: exec srialpop\r

3. Put one empty string in the “Navigate Mid” resource.

Resources for dialing directly in to a UNIX machine

Srialpop takes care of the terminal settings for you.

Note: A plug-in with these strings in it is part of the Eudora distribution.
The file name is “Direct UNIX Navs.”

Need More Options?
If Eudora’s scripting isn’t adequate for you, one alternative is the Calypso
connection tool. It lets you use CCL scripts for the connection/disconnection
process. Calypso can be found on major Macintosh archive sites.
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Introduction
This appendix discusses in detail how Eudora handles character sets and character
set transliteration.

Terminology
Before discussing how Eudora handles character sets, there are some terms that
need to be defined.

A character is a basic unit of written language; a letter, a number, or a
punctuation mark (or in some languages, a whole word or phrase). Major
modifications to a letter (for example, capitalization or the addition of an accent
mark) make that letter a separate character unto itself. “A,” “a,” “à,” and “á” are
all different characters, as are “B,” “0,” “.” and so on.

A character code is a number that is used to represent a given character. Since
computers really work only with numbers, character codes are required to allow
computers to deal with letters, words, and even user manuals.

A character set is a group of characters and their character codes. For example,
we might decide to base a character set on the English alphabet, and simply
number the capital letters from 1 to 26:

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18

19
20
21
22
23
24
25
26

A
B
C
D
E
F
G
H
I

J
K
L
M
N
O
P
Q
R

S
T
U
V
W
X
Y
Z

A Simple Character Set

Now, if we wanted to spell “CAT,” we’d use the numbers 3, 1, and 20.
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The US-ASCII Character Set
The character set described above is a simple one. Too simple, in fact. What if
you want to spell “The cat sat on the mat.”? You can’t, because there are only
capital letters and no space or period. A long time ago, a character set was devised
to fit much common United States English usage. This character set has come to
be known as “US-ASCII.” It is considerably richer than just capital letters:

96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111

`
a
b
c
d
e
f
g
h
i
j
k
l
m
n
o

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

tab
lf

cr

32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47

space

!
"
#
$
%
&
'
(
)
*
+
,
-
.
/

64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79

@
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O

16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31

112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127

p
q
r
s
t
u
v
w
x
y
z
{
|
}
~

48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63

0
1
2
3
4
5
6
7
8
9
:
;
<
=
>
?

80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95

P
Q
R
S
T
U
V
W
X
Y
Z
[
\
]
^
_

The US-ASCII Character Set

Using US-ASCII, you can write “The cat sat on the mat.” using this sequence of
numbers: 84, 104, 101, 32, 99, 97, 116, 32, 115, 97, 116, 32, 111, 110, 32, 116,
104, 101, 32, 109, 97, 116, 46.

The US-ASCII character set is the one in widespread use on the Internet. Most
Internet programs assume you are using it, and most Internet programs don’t
support any other. However, what if you want to write “André sat on the mat.”?
There is no character code in US-ASCII for “é”; so how do you tell the computer
what you mean?
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The Macintosh Character Set
The Macintosh allows us to describe our friend André’s perching habits. The most
common Macintosh character set has a character code for “é,” as well as many
other non-US characters.

96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111

`
a
b
c
d
e
f
g
h
i
j
k
l
m
n
o

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

tab
lf

cr

32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47

space
!
"
#
$
%
&
'
(
)
*
+
,
-
.
/

64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79

@
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O

16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31

112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127

p
q
r
s
t
u
v
w
x
y
z
{
|
}
~

48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63

0
1
2
3
4
5
6
7
8
9
:
;
<
=
>
?

80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95

P
Q
R
S
T
U
V
W
X
Y
Z
[
\
]
^
_

128
129
130
131
132
133
134
135
136
137
138
139
140
141
142
143

Ä
Å
Ç
É
Ñ
Ö
Ü
á
à
â
ä
ã
å
ç
é
è

144
145
146
147
148
149
150
151
152
153
154
155
156
157
158
159

ê
ë
í
ì
î
ï
ñ
ó
ò
ô
ö
õ
ú
ù
û
ü

160
161
162
163
164
165
166
167
168
169
170
171
172
173
174
175

†
°
¢
£
§
•
¶
ß
®
©
™
´
¨
≠
Æ
Ø

176
177
178
179
180
181
182
183
184
185
186
187
188
189
190
191

∞
±
≤
≥
¥
µ
∂
∑
∏
π
∫
ª
º
Ω
æ
ø

192
193
194
195
196
197
198
199
200
201
202
203
204
205
206
207

¿
¡
¬
√
ƒ
≈
∆
«
»
…
 
À
Ã
Õ
Œ
œ

208
209
210
211
212
213
214
215
216
217
218
219
220
221
222
223

–
—
“
”
‘
’
÷
◊
ÿ
Ÿ
⁄
¤
‹
›
fi
fl

224
225
226
227
228
229
230
231
232
233
234
235
236
237
238
239

‡
·
‚
„
‰
Â
Ê
Á
Ë
È
Í
Î
Ï
Ì
Ó
Ô

240
241
242
243
244
245
246
247
248
249
250
251
252
253
254
255

Ò
Ú
Û
Ù
ı
ˆ
˜
¯
˘
˙
˚
¸
˝
˛
ˇ

The Macintosh Character Set

As you can see, the Macintosh character set is much larger than US-ASCII. In
fact, it’s twice as large. The first half (character codes from 0 to 127) of the
Macintosh character set is the same as US-ASCII. However, there are another 128
characters, with character codes from 128 to 255.

So, using the Macintosh character set, we can write “André sat on the mat.”
because there is a character code for “é,” 142.
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The ISO Latin-1 Character Set
Unfortunately, not everyone uses a Macintosh, so not everyone has access to the
Macintosh character set. The character sets that other computers use vary greatly.
Most of them use character sets that are the same as US-ASCII for character codes
from 0 to 127. However, if they provide characters beyond US-ASCII, they often
do so with character codes other than the ones chosen by the Macintosh. That is,
on some computers “é” doesn’t have a character code of 142, but might instead
have a character code of 237. So, if they sent you some text with “André” in it, it
would come out on your screen as “AndrÌ,” which would not be terribly effective.

In order to solve this sort of problem, some standard character sets have been
agreed to. One popular character set is called “ISO Latin-1,” or “ISO 8859-1.”
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The ISO Latin-1 Character Set
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One computer can tell another “Let’s use ISO Latin-1,” and then both computers
will know that the character code for “é” is 233 when they’re talking to each
other, even though one may usually use 142, and the other might usually use 237.

Quoted-Printable Encoding
There is, however, a problem with using the ISO Latin-1 character set. SMTP (the
protocol used to move mail around the Internet) cannot use character codes
greater than 128. So our beautiful “é,” with its character code of 233, cannot be
sent over the Internet. If you try, chances are it will get 128 subtracted from its
value, making it 105, which is “i.” “André” becomes “Andri,” which just won’t
do.

This problem is avoided by the use of “quoted-printable” encoding. To represent a
character using quoted-printable encoding, your mailer converts the value of the
character to two hexadecimal digits and precede them with an equals sign. So, “é”
becomes “=E9” while your mail is being sent. Your recipient’s mailer then
changes the “=E9” back into an “é” and:

«Il est démontré, disait-il, que les choses ne peuvent être autrement;

car tout étant fait pour une fin, tout est nécessairement pour la

meilleure fin.» -- Voltaire, “Candide”

Quoted-printable encoding is a wonderful thing when it works. The problem is
that not all mailers are as forward-thinking as Eudora, and they do not all support
MIME. If your recipient doesn’t have MIME, they can find the presence of
quoted-printable encoding to be more objectionable than the mangling of a few
special characters. They may wish they could get “André,” but if they can’t, they
might rather have “Andri” than “Andr=E9.”

Also, if quoted-printable encoding is used, it affects more than just international
characters. Since “=” is used in the encoding, it must be encoded specially, and all
the equals signs in your mail will be turned into “=3D” while your mail is sent.
Moreover, mail encoded in quoted-printable must have lines no more than 76
characters long; lines longer than that will be split in two, and an equals sign
placed at the end of the first line. All this damage gets repaired if the recipient has
a MIME mailer, but if they don’t, it can be quite unpleasant.

QUALCOMM Incorporated 153



Appendix E – Character Sets Eudora User Manual

Disabling Quoted-Printable Encoding
If your recipient doesn’t have a MIME mailer, there are several ways to avoid
using quoted-printable encoding. These are described below.

Don’t Use International Characters
The simplest way to avoid quoted-printable is to not use any international
characters. Avoid “André,” and Eudora won’t use quoted-printable. When Eudora
sends plain text attachments and the Always include Macintosh information
switch is off (in the Attachments Settings), Eudora samples the first 16 Kbytes of
the attachment file, and if that text contains no long lines or international
characters, Eudora does not use quoted-printable.

Use Fix Curly Quotes
The Fix Curly Quotes switch is a way to avoid using quoted-printable if your mail
contains just a few select special characters; namely the “curly quotes” (“”‘’),
bullet (•), and en and em dashes (– and —). Since these characters often appear in
Macintosh documents, but have very reasonable US-ASCII equivalents, some
users choose to have these characters changed into US-ASCII. If you turn Fix
Curly Quotes on, these characters will be changed into US-ASCII, and they won’t
invoke quoted-printable.

Use the US-ASCII Transliteration Table
Another way to avoid quoted-printable is to install EudoraTables and choose the
US-ASCII transliteration table (see the section “Transliteration Tables”). This
maps all international characters to their nearest US-ASCII equivalents. “André”
will become “Andre”; not great, but perhaps better than “Andri” or “Andr=E9.”

Turn Off the QP Icon
The QP icon on the icon bar of a composition window controls whether or not
Eudora is allowed to use the quoted-printable encoding. If you uncheck the QP
icon, Eudora won’t use quoted-printable for that message, no matter what.

Turn Off the May Use QP Switch
The May use Quoted-Printable option in the Sending Mail Settings dialog
controls the default setting of the QP icon. If you turn this off, messages you
create will never use quoted-printable encoding.
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Transliteration Tables
When Eudora sends mail that includes characters like “é,” it normally
“transliterates” them (Eudora changes the character code from the Macintosh
character set to the ISO Latin-1 character set). So, “é” gets changed from 142 (the
Macintosh character code) to 233 (the ISO Latin-1 character code). When Eudora
receives mail, the reverse is done, and 233 becomes 142.

This process is controlled by “transliteration tables” (“tables” for short) that are
stored as ‘taBL’ resources. A table consists of 256 numbers. Tables are used by
using the character code to be transliterated as an index into the table, and
replacing it with the value found at that position in the table. For example, when
transliterating an “é” from the Macintosh character set to ISO Latin-1, we look at
place 142 in the table (142 is the Macintosh character code for “é”); there we find
a 233 (the ISO Latin-1 character code for “é”), and so we replace 142 with 233.

Eudora comes with five ‘taBL’ resources. Their resource id’s and purposes are as
follows:

1001 ISO Latin-1 to Macintosh. This table is used to transliterate from
character codes in ISO Latin-1 to character codes in the Macintosh
character set.

1002 Macintosh to ISO Latin-1. This table is used to transliterate from the
Macintosh character set to the ISO Latin-1 character set.

1003 Identity table. This table is provided as a reference for people who
wish to write their own tables.

1004 Fix curly quotes table. This table is used by the Fix Curly Quotes
switch, for people who would rather stick to US-ASCII where
possible.

1005 US-ASCII. This table is used to transliterate file names for
attachments.

More Tables
If ISO Latin-1 is not the character set for you, it is possible to get Eudora to offer
you more choices. Simply drag the EudoraTables document into your Preferences
folder within your System Folder:
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Installing the EudoraTables document

Once EudoraTables has been installed, launch Eudora. The Change submenu
under the Message menu now has some new choices. These choices allow you to
control how your mail is transliterated.

Menus with Transliteration Tables
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Incoming Messages
The table (if any) that is being used to display the current message is checked.
The table that is used by default (if any) to view messages is outlined.

To change the table that is used to display a message, select the table you want to
use from the Transliteration submenu. The message is redisplayed using that
table, and that table is used to display the message from then on.

Outgoing Messages
The table (if any) that is used when the current message is sent is checked. The
table that is used by default (if any) when sending messages is outlined.

To change the table that is used to send the message, select the table you want to
use from the Transliteration submenu.

Default Tables
If you usually want to view or print your mail with a particular table, hold down
the shift key when selecting the table from the Transliteration submenu for an
incoming message. The table title is outlined in the Transliteration submenu to
show that it is the default table, and from then on your messages are viewed with
that table, unless you specify otherwise.

Note: If an incoming message uses MIME and Eudora knows the
character set the message uses, the message is transliterated
before it is stored, and a viewing table is not needed or used.

If you usually want to use a particular table for outgoing mail, hold down the shift
key when selecting the table from the Transliteration submenu for an outgoing
message. The table title is outlined in the Transliteration submenu to show that it
is the default table, and from then on your messages are sent using that table,
unless you specify otherwise.

To clear the default table, hold down the shift key and select the outlined table
from the appropriate menu. The default then becomes no table.

No Table At All
If you want a particular message not to be displayed (or sent) with any table,
select the Transliteration submenu. The table in effect for that particular message
is checked. Choose the checked item; the check mark is erased and no table is
used when that message is displayed (or sent).
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Summaries
For non-MIME mail, the sender and subject lines are run through the default
viewing table when mail arrives, and placed in the message summary (for display
in mailbox windows and in the editable subject area). Subsequent viewing table
changes won’t affect the summaries. For incoming MIME mail, no such
transliteration is done, because MIME has a mechanism for specifying character
sets in names and subjects.

Ph and Finger
Ph and finger queries are transliterated according to the tables chosen at the
bottom of the window:

Controlling transliteration in the Directory Services window

What you type is transliterated with the “Query Table,” and the server’s response
is transliterated with the “Result Table.”

Attachments
Transliteration tables are normally not used when sending or receiving
attachments, unless those attachments are plain text documents. If the attachments
are plain text documents, they will be transliterated if the Always include
Macintosh information option is turned off in the Attachments Settings, or if the
AppleDouble attachment type is chosen.
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Creating New Tables
If you are trying to use a character set that Eudora doesn’t understand, you can
build tables for it. You will need to create two ‘taBL’ resources, and probably
your own ‘euTM’ resource as well.

Choosing Resource Id’s
You need to choose two resource id’s for your tables. These id’s should be
consecutive, with the lower-numbered id being odd. The odd-numbered id is used
for incoming mail, and the even-numbered id is used for outgoing mail. In order
to avoid id conflicts, take the Macintosh country code, multiply by 10, add 2000,
and add 1 if the table is for incoming mail, or 2 if the table is for outgoing mail.
For example, the table that maps Swedish ASCII to Macintosh characters is:

10*7 (seven is the country code for Sweden) + 2000 + 1 (since the table is used
for receiving mail), or 2071.

Creating the ‘taBL’ Resources
Once you’ve chosen id’s, make the ‘taBL’ resources. ResEdit’s general editor
works quite well for tables. You will probably wish to copy the ‘taBL’ resource id
1003 to serve as a starting point. That way, you only need modify the parts of the
Macintosh character set that need to be transliterated. The names of the resources
will be used in the menus, so name the table resources descriptively. It’s also a
good idea to create your resources in a “plug-in” file; a file with type ‘rsrc’ and
creator ‘CSOm’. That way, users can easily install and remove your table, and
your table won’t get wiped out if they upgrade their copy of Eudora or
EudoraTables.

Creating an euTM
The ‘euTM’ resource is used for naming character sets. Character sets must be
named so that mailers know which character set is being used. The official MIME
names for character sets are often very unpleasant. For example, the name for a
common Swedish character set is “SEN_850200_B.”
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Part of an euTM Resource

The ‘euTM’ resource is a list of resource id’s and names. When Eudora is sending
mail, it will subtract 1 from the table’s resource id, then look for that resource id
in all the ‘euTM’ resources it can find. When it finds a matching id, the name
corresponding to the id is used.

For example, a user choosing the Mac->se table would be using table id 2072.
Eudora subtracts one, finds 2071 in the second position in the ‘euTM’ resource,
and sends the mail with a character set name of “SEN_850200_B.”

When receiving mail, the process is reversed; the character set name is looked up,
the resource id found, and that transliteration table used for the mail.

For your table, you should create an ‘euTM’ resource, list the resource id of your
table (only the odd id), and list the name that should be used in mail for the
character set.
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Introduction
Eudora works with UUCP in almost exactly the same way as it works with the
POP and SMTP servers. Attachments are supported, as is regular mail checking
and the other features. It is possible to mix methods; for example, you can use
UUCP for reading mail but SMTP for sending it.

Eudora does not come with UUCP. Three available Macintosh UUCP systems are
“uupc 3.0” (dplatt@snulbug.mtview.ca.us), “gnuucp” (jim@fpr.com), and
“UUCP/Connect” (formerly “µAccess,” sales@intercon.com). “UUCP/Connect”
is commercial; the other two are freeware. Eudora has been tested with all three
packages; it works well with uupc 3.0 and UUCP/Connect, but it does not work
very smoothly with gnuucp.

Settings Dialog for UUCP

Personal Information Settings for UUCP
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Hosts Settings for UUCP

POP Account
If you are going to receive mail via UUCP, you should put the full path name of
your “mail drop” (the file where UUCP leaves mail for you) in the POP account
field. Precede the name with an exclamation point.

TCP/IP or Communications Toolbox
This setting (Connection method in the Getting Started Settings) doesn’t matter
if you’re doing pure UUCP mail. If you’re trying to mix UUCP with SMTP or
POP, set this to whatever is appropriate for your SMTP or POP connection.

SMTP Server
If you want to send mail via UUCP, several items have to go in the SMTP field.
Each one should be preceded by an exclamation point. The items are, in order:

mac - the UUCP name of your Macintosh.

spoolpath: - the full path name of the UUCP working directory.

user - your user name on your Macintosh.

0000 - a four-digit sequence number; will be incremented by Eudora.

Return Address
If you use UUCP for reading your mail, you must put your correct return address
in the Return address field. It is absolutely vital that this address be correct. If
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it’s wrong, no one is able to reply to your mail and the mail transport system is
unable to tell you your mail can’t be delivered.

Operation
Almost all Eudora features work normally with UUCP. The one exception is the
Leave on server for ? days option in the Checking Mail Settings. When Eudora
is used with POP and this option is on, only unread mail is downloaded. With
UUCP, however, Eudora does not distinguish between read and unread mail; it
downloads all the mail at each check. This results in duplicate messages, unless
you use some other means to clean out your mail drop between Eudora checks. It
is suggested that this option remain off when using UUCP.

Internals
Mail Drop Format
Eudora expects the mail drop to be in standard UNIX mailbox format, with UUCP
envelopes (“From” lines) at the beginning of each message. The mail drop should
use carriage returns (not line feeds) for new lines.

Working Files
When sending mail, Eudora creates two files in the UUCP work directory. These
files are as follows:

D.mac0####
The message itself is put in this file. As distributed, Eudora uses returns for new
lines in this file. That can be changed by editing the last characters of STR#
resource id 8000, string 5; Eudora will use whatever nonprintable characters are at
the end of the string. The mail begins with a UUCP envelope. The “####” stands
for the four-digit sequence number mentioned above in the section “SMTP
Server.” It increments as each message is sent.

X.mac0####
Commands for the UUCP system are put in this file. These commands are all
editable via ResEdit; they are distributed with returns at the ends.

U user mac

; identifies you (STR# id 8000, string 1)

F D.mac0####

; this file contains your message (8000,2)
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I D.mac0####

; use your mail for input (8000,3)

C rmail recipient...

; all recipients of the mail are listed here (8000,4)
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What is MIME?
“MIME” stands for Multipurpose Internet Mail Extensions. MIME serves two
major purposes: it allows mail applications to tell one another what sort of data is
in mail, and it also provides standard ways for mail applications to encode data so
that it can be sent through the Internet mail system.

MIME Encodings
The Internet uses SMTP (Simple Mail Transfer Protocol) to move mail around.
SMTP is limited to the US-ASCII character set (see Appendix E). This is a
problem for people who speak languages other than American English and so
need accented characters or non-American letters, or for people who want to use
special symbols like the section mark (§).

MIME provides a way around this restriction. It offers two encodings, “quoted-
printable” and “base64.” These encodings use US-ASCII character codes to
represent any sort of data you like, including special characters or even non-text
data.

“Quoted-printable” is used for data that is mostly text but has special characters or
very long lines. It’s very simple. Quoted-printable looks just like regular text,
except when a special character is used. The special character is replaced with an
“=” and two more characters that represent the character code of the special
character. So, a section mark (§) in quoted-printable looks like this: “=A8”.

However, there are some other things that quoted-printable does. For one, since it
uses an “=” to mean something special, equals signs must themselves be encoded
(as “=3D”). Second, no line in quoted-printable is allowed to be more than 76
characters long. If your mail has a line longer than 76 characters, the quoted-
printable encoding will break your line in two and put an “=” at the end of the first
line, to signal to the mail reader at the other end that the two lines are really
supposed to be all one line. Finally, a few mail systems either add spaces to or
remove them from the ends of lines. So, in quoted-printable, any space at the end
of a line gets encoded (as “=20”), to protect it from such mail systems.
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Let’s try an example. Here’s a passage of text that you might type on your
Macintosh:

«Il est démontré, disait-il, que les choses ne peuvent être

autrement; car tout étant fait pour une fin, tout est nécessairement

pour la meilleure fin.»

Without any encoding, this might show up on your recipient’s screen as:

+Il est dimontri, disait-il, que les choses ne peuvent btre

autrement; car tout itant fait pour une fin, tout est nicessairement

pour la meilleure fin.;

This corruption happens because SMTP cannot handle the special characters.
However, if you and your recipient both have MIME, quoted-printable encoding
would be used, and your text would show up properly:

«Il est démontré, disait-il, que les choses ne peuvent être

autrement; car tout étant fait pour une fin, tout est nécessairement

pour la meilleure fin.»

While your mail was actually in transit, however, it would have looked like this:

=ABIl est d=E9montr=E9, disait-il, que les choses ne peuvent =EAtre

=

autrement; car tout =E9tant fait pour une fin, tout est n=E9cessairement =

pour la meilleure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP mail
system. However, Base64 makes no attempt to be legible, and is most appropriate
for non-text data.
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MIME Labeling
The other important part of MIME is that it lets mailers communicate what kind
of data is in a message (or part of a message). The primary mechanism used for
this is the Content-Type header:

Content-Type: text/plain; charset=iso-8859-1

A content-type header is divided into three parts: the content type, the content
subtype, and the parameters. In this case, the content type is “text,” meaning the
message contains mostly legible text. The content subtype is “plain,” which
means there aren’t any formatting commands or anything like that embedded in
the text. Finally, “charset=iso-8859-1” is a parameter; in this case it identifies the
character set the message uses.

The major content types are as follows:

text legible text

image pictures and graphics

audio sound

video moving pictures

message messages or pieces of messages

multipart several different kinds of data in a single message

application everything else

Practical Issues
There are really only two things you sometimes need to do with Eudora and
MIME. One is that it may occasionally be necessary to turn off quoted-printable
encoding. Another is that you may want to know how to define mappings between
MIME types and Macintosh types.

Turning Off Quoted-Printable
Eudora automatically uses quoted-printable encoding if your mail or your plain
text attachments contain special characters. If your recipients don’t have MIME,
quoted-printable can hurt more than it helps. If that’s the case, just turn off the QP
icon in the outgoing message icon bar when you are sending text files to those
recipients.
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Mapping Between MIME Types and Macintosh Types
When you send attached files to other Eudora users, Eudora automatically knows
what kind of data is in the files, because Eudora sends along special information
with the file. However, if you’re sending the file to a non-Macintosh user, or
receiving files from a non-Macintosh user, it’s important to get the right MIME
type information on the file, or for Eudora to understand what the MIME type
information means.

Eudora knows about some MIME types. However, since new MIME types are
being defined all the time, it may be necessary to add to Eudora’s knowledge from
time to time. If you’re familiar with ResEdit, this isn’t too hard to do.

The way Eudora maps between MIME and Macintosh types is with EuIM and
EuOM resources. EuOM resources are used for sending attachments, EuIM for
receiving. They have the same basic structure.

EuOM and EuIM resources are lists of individual elements called “maps.” Each
map describes a Macintosh document type (or MIME data type) and then lists
what MIME data type (or Macintosh document type) it corresponds to. For any
given type, Eudora looks through all the maps in all the EuOM or EuIM
resources, and uses the best match.

Sending
When you create a map in an EuOM resource, you use the “Creator Code” and
“Type” fields to specify what documents the map applies to. These fields should
be filled with the four-byte creator code or Macintosh type of the documents you
want to send. If you leave the Creator Code blank, but fill in the type, the map is
used for any document of that type, regardless of creator. If you fill in both
Creator Code and Type, a document has to match both for the map to be used.
Given the choice, Eudora uses the map that matches both creator and type.

The other parts of the map are used to construct the MIME information. Content
Type and Content SubType are the MIME type and subtype to use for the
document. Filename suffix allows you to tell Eudora to add a suffix to the
filename, as an extra hint to the receiving system (for example, you might have
Eudora add “.xls” to Excel files).

“Newline conversion?” tells Eudora whether or not to convert carriage returns in
the file to carriage return, linefeed. Usually, you should set this to 1 for text data,
but to 0 for binary files.
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Finally, “May suppress resource fork?” is used in conjunction with Eudora’s
Always include Macintosh information option (in the Attachments Settings). If
you set this to 1, and Always include Macintosh information is off, Eudora
won’t send Macintosh type and creator information with the file, and won’t send
the resource fork. Instead, it will just send the data fork with the MIME
information attached to it.

An Example Map in an EuOM Resource

The map above says that all files of type “EPSF,” no matter what the creator,
should be sent as “application/postscript,” that “.eps” should be added to the
filename, that carriage returns should not be turned into carriage return/linefeed
pairs, and that when the Always include Macintosh information switch is off,
the resource fork won’t be sent.

Receiving
EuIM resources are used for receiving files. They’re pretty much the same as
EuOM resources, except that the MIME type and subtype are used for matching,
and the Macintosh creator code and type are applied to the file received.

As with EuOM resources, you can leave parts blank. If you want to match all files
with an “.eps” suffix, regardless of the MIME type or subtype, leave the type and
subtype blank. If you don’t care what the filename suffix is, leave that blank and
match with the MIME type and/or subtype only. Again, as with EuOM resources,
Eudora will choose the map that matches best.
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With EuIM resources, it’s sometimes a good idea to use several maps to catch all
important cases. For example, it might be a good idea to have three maps for
dealing with PostScript files, as follows:

Content Type: application
Content SubType: postscript
Filename suffix:
Creator Code: mlpr
Type: TEXT

This map will catch most MIME PostScript files, and set their creator to MacLPR.

Content Type:
Content SubType:
Filename suffix: .eps
Creator Code: dPro
Type: EPSF

This map will match any incoming file with a suffix of “.eps,” regardless of the
MIME type info, and set its type to “EPSF” and creator to “dPro” (MacDraw
Pro). But what if a file comes in with a suffix of “.eps” and a MIME type/subtype
of “application/postscript”? Which map gets used? The first one gets used; when
Eudora has a choice between matching a suffix and matching MIME type
information, MIME wins. A third map may be in order:

Content Type: application
Content SubType: postscript
Filename suffix: .eps
Creator Code: dPro
Type: EPSF

This makes application/postscript files with suffixes of “.eps” get type EPSF and
creator dPro.
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Symbols Recipient List option 86

removing entries from 86
“me” nickname, for personal identification 44, 46,
116

resizing 84
saving changes to 86

-, in the Status column 61 saving entries to a file 89
•, in the Status column 24, 34, 42, 43, 50, 61 type to select entries in 84
6000.17 147 using non-Eudora nicknames 89
7400.13 147 View By option 84
???@??? 62 Address Book command 83, 129
\b 146 Address(es) field 85
\D 146 After transferring or deleting or paging past end of

current message, open option 118\e 146
\h 145 Aliases
\n 145 mailboxes 130
\p 145, 146 Settings files 96
\r 145 Always include Macintosh information option 109
\s 145 and option 75
\u 145 Any Header field 73
\\ 145 Any Recipient field 73
µAccess 161 APOP option 106

appears option 74
AppleDouble encoding 39A
AppleSingle encoding 39

Address Book Arrow+these modifiers to switch messages option
118adding nicknames to the Quick Recipient List

86 Attach Document command 38, 39, 127
Address(es) field in 85 Attachment Folder 53
addressing a message from 87 Attachment Folder option 54, 109
changing entries in 86 conflicts with 54
creating a message from 86 Attachment Type popup 32
creating new entries in 84 Attachments
displaying entries in 84 Always include Macintosh information option

109dragging entries to another file in 86
Make Address Book Entry command from 87 and UUCP 161
maximum entries in 85 attaching files to outgoing mail 38
Name field in 85 Attachment Folder 53, 109
New button in 84 changing 54
Notes field in 85 conflicts with 54
paging up and down in 84 automatically deleting 69
printing 84 copying 53
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detaching from a message 38 And dialups 143
dragging to attach 38 Cc button
encoding 38 in the Address Book 86
Encoding method option 109 Cc field
moving 53 in Filters 73
opening 53 in outgoing mail 23, 33
receiving 53 Change Password command 49, 129
showing location 53 Change Queueing command 41, 43, 127
TEXT files belong to option 110 Change Queueing dialog 40, 41
Trash attachments with messages option 110 Change submenu 127

Attachments column 62 Check for mail every ? minutes option 47, 105
Attachments Folder 69 Check mail
Attachments Settings 109 automatically 47, 105

Always include Macintosh information option
109

Check for mail every ? minutes option 47
Check Mail command 48

Attachment Folder option 109 Delete from server when emptied from trash
option 56Encoding method option 109

TEXT files belong to option 110 entering password 48
Trash attachments with messages option 69,
110

Fetch icon 57
Forget Password command 49

Authentication option 106 Leave on server option 56, 106
manually check 48
minimum interval 47

B Save password option 49
Skip messages over ? K option 57, 106Background Color option 111
stopping 48backslash 145

Check Mail command 25, 26, 47, 48, 49, 123Balloon Help 22
Checking Mail Settings 56, 105Bcc button

Authentication option 106in the Address Book 86
Check for mail every ? minutes option 47, 105Bcc field
Delete from server when emptied from trash
option 56, 106

in outgoing mail 23, 33
BinHex encoding 39

Don’t check when using battery option 106BLAH BLAH BLAH icon 51
Leave on server option 56, 106blank, in the Status column 61
Overlap POP3 commands option 106Blind copy
POP account option 105with Bcc field 33
Save password option 49, 106with Name field in Address Book 85
Send on check option 106Body field 73
Skip messages over ? K option 57, 106Bounced mail 46

Checkmark on Icon bar 32Break 146
Choose button 79
Clear command 124

C Close All command 123
Close command 123Carriage return 145, 147
Close messages with mailbox option 119
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Communications command 129 Detaching attachment 38
Communications Toolbox 143 Dialin password 145
Compact Dialin username 145

all mailboxes 63 Dialup 143
one mailbox 63 Dialup username option 103

Composition window 23, 31 Direct UNIX Navs 148
Connecting to servers with dialup 147 Directory Services
Connection method option 18, 102 addressing a message from 93
Connection tool 144 finding Ph servers 92
Connection Tools 17 Finger button 91
contains option 74 Finger option 104
Convert Hesiod names to lower-case option 120 Finger queries 92
Copy & Unwrap command 37, 124 Live Ph queries option 105
Copy blind Ph button 91

with Bcc field 33 Ph option 104
with Name field in Address Book 85 Ph queries 91

Copy command 61, 124 with the shift key 91
and styled text 37 Directory Services command 91, 129

Copy original’s priority to reply option 36, 44, 116 Disconnect MacSLIP if Eudora connected it option
117Copy To action 76

Copy Without Styles & Unwrap command 37, 124 Display dates using option 112
Copy Without Styles command 37, 124 DNS load balancing option 104
Copying a message to a mailbox 70 does not appear option 74
Copying message summaries 61 does not contain option 74
Correct (but slow) international sorting option 120 Domain to add to unqualified names option 107
CSOm 144 Don’t check when using battery option 106
Current maintenance release Don’t make automatic checks when MacSLIP is

not already connected option 117how to determine 96
Current Message 27 Don’t Send option 42, 43
Cut command 124 Draw separator lines option 122

D E

D, in the Status column 45, 61 Echo and dialups 143
Date column 62 Edit
Date Display Settings 112 incoming mail 55

Date formats option 112 Edit menu 124
Display dates using option 112 Empty the Trash mailbox option 115

Date formats option 112 Empty Trash command 30, 56, 69, 129
Decoding 39 Empty Trash on Quit option 19, 56, 69, 119
Delay 146 EMSAPI 95
Delete command 29, 69, 127 Encoding method option 109
Delete from server when emptied from trash option
56, 57, 106

Encoding methods
AppleDouble 39
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AppleSingle 39
BinHex 39

Fends with option 74
Enter key 50 F, in the Status column 44, 61
Enter Selection command 78 Fetch icon 52, 57
Eudora Folder File menu 123

Eudora Filters file 130 Filter Messages command 72, 128
Eudora Log file 130 Filters
Eudora Nicknames file 130 and option 75
Eudora Settings file 130 appears option 74
In file 130 automatically named 72
Mailbox Aliases 130 Conjunction field 75
Out file 130 contains option 74
Signature Folder 130 Copy To action 76
Spool Folder 130 does not appear option 74
Trash file 130 does not contain option 74

Eudora Information 133 ends with option 74
Eudora Light Folder 131 Forward To action 76

Extras Folder 131 Generate filter reports option 120
Dialup Folder 131 header field 73
Plugins Folder 132 ignore option 75

README file 131 Incoming option 72
Expect 146 intersects nickname option 74
Extended Services command 95 invoked from top to bottom 73
Extended Services submenu 125 is not option 74
Extra Warnings Settings 41, 114 is option 74

Empty the Trash mailbox option 115 Last used field 76
Set a changed message back to read-only
option 115

Make Label action 75
Make Priority action 75

Try something that requires too much memory
option 115

Make Status action 75
Make Subject action 76

Try to delete any unsent mail option 69 Manual option 72
Try to delete any unsent messages option 114 Match Type field 73
Try to delete queued mail option 69, 114 Matching Text field 74
Try to delete unread mail option 69, 114 None action 75
Try to queue a message with no subject option
114

Notify User action 76
Open action 76

Try to quit with messages queued to be sent
option 115

or option 75
Outgoing option 72

Try to send a message whose size is more than
? K option 115

Play Sound action 76
Print action 76
re-ordering 73
Redirect To action 76
Reply With action 76
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resizing the list 73 Require control key for text/message dragging
option 120Server Options action 76

Skip Rest action 76 Unwrap Selection 37
starts with option 74 When receiving styles, pay attention to option

122Transfer To action 76
unless option 75 Wrap Selection 37

Filters command 71, 129 Forward
Filters window 71 quoting original text 44

New button in 72 Forward command 44, 126
Find Again command 79 and styled text 37, 44
Find button 79 with the option key 44
Find command 78 Forward To action 76
Find dialog 78 Forward To submenu 90, 126
Find submenu 128 Forwarded (F) status 44
Finding text From field

Match Case option 79 in a forwarded message 44
Search mailbox option 80 in Filters 73
Search mailfolder option 80 in outgoing mail 23, 33
Search To End option 80 in redirected message 45
Summaries only option 80 ftp.eudora.com 133
within a message 79
within mailboxes and folders 79

GFinger button 91, 92
Finger option 104 Generate filter reports option 120
Finish & Expand Address Book Entry command
89, 125

Getting Attention Settings 113
Flash an icon in the menu bar option 50, 113

Finish Address Book Entry command 89, 125 Open mailbox option 50, 113
Fix curly quotes option 108 Play a sound option 50, 113
Flash an icon in the menu bar option 50, 113 Say OK to alerts after 2 minutes option 114
Fonts & Display Settings 110 Use an alert option 50, 113

Background Color option 111 Getting Started Settings 17, 101
Message window height option 111 Connection method option 18, 102
Message window width option 111 POP account 47, 102
Print Font and Size options 111 POP account option 18
Screen Font, Size, and Text Color options 110 Real name option 18, 102
Waste cycles drawing trendy 3D junk option
111

globe 92
gnuucp 161

Zoom windows when opening option 111 Guess Paragraphs option 81
Forget Password command 49, 129
Formatting text

HCopy & Unwrap 37
Copy Without Styles 37 Help
Copy Without Styles & Unwrap 37 what to do if all else fails 22
dragging text 37 Help menu 21
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Hesiod, definition 120 Insert Recipient command 90, 125
Hide Balloons command Inserting a file 39

on Macintosh Help menu 22 Installation 13
Hide the recipient list Connection Tools 17

with Bcc field 33 Internet Config
with Name field in Address Book 85 read from option 120

Hosts Settings 91, 104 write to option 120
DNS load balancing option 104 intersects nickname option 74
Finger option 104 is not option 74
Live Ph queries option 105 is option 74
Overlap POP3 commands option 105
Ph option 104

KPOP account option 104
SMTP option 104 Keep copies of outgoing mail option 46, 108

Hot link Keep Copy icon 32, 46
in incoming mail 55 Kerberos 134

Kerberos option 106

I
LIcon Bar

in incoming mail 51 Last used field 76
in outgoing mail 32 Leave on server for ? days option

ignore option 75 and UUCP 163
Ignoring previously read messages 56 Leave on server option 56, 106
Immediate send option 40, 41, 107 Linefeed 145, 147
In command 125, 128 Live Ph queries option 92, 105
In mailbox 50 Lock whole program in memory option 119
Include Headers option 81
Include Macintosh Information icon 32, 39

MInclude yourself option 44
Incoming message window MacSLIP Cooperation Settings 117

Icon bar 51 Disconnect MacSLIP if Eudora connected it
option 117BLAH BLAH BLAH icon 51

Fetch icon 52 Don’t make automatic checks when MacSLIP
is not already connected option 117Pencil icon 51

Priority popup 51 Mail drop 162
Subject field 52 Mail drop format 163
Tow Truck icon 52 Mail folders

Message body 52 creating during transfer 70
Title bar 51 creating in the Mailboxes window 67
zooming the window 111 New button 67

Incoming option 72 creating using Mailbox menu 64
Insert & Expand Recipient command 90, 125 Make it a folder option 64
Insert button 39 moving in the Mailboxes window 68
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Move buttons 68 Mailboxes window 65
New command 64 Make Address Book Entry command 87, 88, 92,

128removing
Remove button 68 from a mailbox 88

removing in the Mailboxes window 68 from Directory Services 88
renaming in Mailboxes window from selection 87

Rename button 67 from the Address Book 87
Mail Storage 130 Make Address Book Entry From Selection

command 87, 128Mailbox Columns Settings 63, 122
Draw separator lines option 122 Make it a folder option 64, 65, 67
Show columns options 122 Make Label action 75

Mailbox menu 125 Make Priority action 75
Mailboxes Make Status action 75

Close messages with mailbox option 119 Make Subject action 76
compacting all 63 Managing mail on the server
compacting one 63 Delete from server when emptied from trash

option 56, 106creating during transfer 70
creating in folders 65 Fetch icon 57
creating in the Mailboxes window 67 Leave on server option 56, 106

New button 67 Skip messages over ? K option 57, 106
creating using Mailbox menu 64 Manual option 72
displaying columns 63 Match case option 79
Draw separator lines option 122 May use Quoted-Printable option 108
Make it a folder option 64 Message body
message summaries 60 in incoming mail 52
moving in the Mailboxes window 68 in outgoing mail 23, 34

Move buttons 68 Message header
New command 64 in incoming mail 52
number of messages 63 in outgoing mail 33
opening 59 Message menu 126
opening from the Mailboxes window 66 Message summaries 60
opening other 59 Attachments column 62
removing in the Mailboxes window 68 changing the subject of 55

Remove button 68 copying 61
renaming in the Mailboxes window 67 Date column 62

Rename button 67 Priority column 61
resizing columns 63 resizing columns 63
Show columns options 122 selecting 60
size display 63 Sender/Recipient column 62
sorting messages in 77 Size column 62
space messages require 63 Status column 61
space wasted 63 Subject column 62
transferring messages among 70 Message window height option 111
zooming windows 111 Message window width option 111

Mailboxes command 65, 129 Miscellaneous Settings 119
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Close messages with mailbox option 119 Next Time Queued Messages are Sent option 42
Convert Hesiod names to lower-case option
120

Nicknames 85
“me” 44, 46, 116

Correct (but slow) international sorting option
120

adding to the Quick Recipient List 86
creating in the Address Book 84

Empty Trash on Quit 69 None action 75
Empty Trash on Quit option 119 Notes field 85
Generate filter reports option 120 Notification
Lock whole program in memory option 119 Flash an icon in the menu bar option 113
Re-sort mailboxes less often option 119 Open mailbox option 113
Read from Internet Config option 120 Play a sound option 113
Require control key for text/message dragging
option 120

Say OK to alerts after 2 minutes option 114
Use an alert option 113

Turbo redirect by default 46 Notify Sender button 52, 53
Turbo redirect by default option 119 Notify User action 76
Use old-style “.toc” files option 120 Nuke command 30, 69, 127
Write to Internet Config option 120

Move buttons 68
OMoving Around Settings 117

After transferring or deleting or paging past
end of current message, open option 118

On or after option 42
Online Help 21

Arrow + these modifiers to switch messages
option 118

Open action 76
Open command 123

Return switches among header fields option
118

Open Eudora 17
Open mailbox option 50, 113

Tab to switch fields, option-tab to insert tab
option 118

Open Selection command 50, 123
or option 75

Multiple accounts on one Macintosh 95 Out command 125, 128
Out mailbox 42, 43, 70
Outgoing message windowN

Icon Bar 32
Name field 85 Attachment Type popup 32
Navigate Include Macintosh Information icon 32

In 144, 147 Keep Copy icon 32
Mid 144 Priority popup 32
Out 144 Queue button 33
special characters 144 Quoted-Printable icon 32

New button in Address Book 84 Send button 33
New button in Filters window 72 Signature popup 32
New command 28, 64, 65, 70, 125, 128 Word Wrap icon 32
New Mailbox dialog 28, 64, 65, 70 Message body 34
New Message command 23, 31, 126 Message header 33
New Message To submenu 90, 126 Attachments field 34
New Text Document command 123 Bcc field 33
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Cc field 33 POP Account hostname 145
From field 33 POP account option 18, 47, 102, 103, 104, 105
Subject field 33 and UUCP 162
To field 33 POP Account password 145

Title Bar 31 POP Account username 145
zooming the window 111 POP server 47, 56, 133, 139

Outgoing option 72 UNIX 133
Overlap POP3 commands for better performance
option 105, 106

VAX/VMS 133
POP version 3 139
Popper 133
Print

P current item 95
selection only 95Page Setup command 123

Print action 76Password
Print command 73, 95, 123changing 49
Print Font and Size options 111server source code for 133
Print One Copy command 95, 124Dialup 146
Print Selection command 123entering 25, 48
Priority column 61forgetting 49
Priority PopupAfter failed expect 146

default for replies 36remembering 49
in incoming mail 51Saving 49, 106
in outgoing mail 32Passwords option 106
levels 36Paste as Quotation command 124
Raise and Lower 36Paste command 124

Progress window 25Pencil icon 51, 55
Put it on the recipient list option 85Personal Information Settings 103
Put original To recipients in Cc field option 44Dialup username option 103

POP account option 103
Real name option 103 Q
Return address option 103

Ph Q, in the Status column 41, 42, 43, 61
button 91 Queue button 25, 33, 41
option 104 Queue mail 41
query 91 Change Queueing command 41, 43
server source code 133 Change Queueing dialog 41

Ph button 91 Don’t Send option 42, 43
Play a sound option 50, 113 editing before sending 42
Play Sound action 76 for a certain time 41
Plugins 144 Immediate send option 41

Esoteric Settings 132 Next Time Queued Messages are Sent option
42Eudora Tables 132

Forward934 132 On or after option 42
Kerberos Settings 132 Queue button 41
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Queue Message command 41 Registration 18
Right Now option 42 Rejected mail 46
Send message Right Now option 41 Remove All button 68
Send Queued Messages command 41 Remove button 68
sending queued mail when checking mail 43 Remove It button 68
taking mail out of the queue 43 Rename button 67

Queue Message command 41, 127 Renaming a mail folder 67
Queued (Q) status 41 Renaming a mailbox 67
Quick Recipient List Replied (R) status 43

Forward To submenu 90 Reply
Insert & Expand Recipient command 90 Copy original’s priority to reply option 44
Insert Recipient command 90 Include yourself option 44
New Message To submenu 90 Put original To recipients in Cc field option 44
putting nicknames on 86 quoting original text 43
Recipient List option 89 Reply command 43
Redirect To submenu 90 Reply Quoting Selection command 43

Quit command 19, 124 Reply to all By default option 44
Empty Trash on Quit option 119 Reply To All command 44

Quoted text Reply command 28, 43, 126
in forwarded messages 44 and styled text 37, 43
in replies 43 Reply Quoting Selection command 43, 126

Quoted-Printable icon 32 Reply Quoting Selection To All command 126
Reply to all By default option 44
Reply To All command 44, 126

R Reply to all option 115
Reply With action 76R, in the Status column 43, 61
Reply-To field 73Re-sort mailboxes less often option 119
ReplyingRead from Internet Config option 120

Copy original’s priority to reply option 116Real name option 18, 102, 103
Reply to all option 115Recipient List option 86, 89
When replying to all option 116Redirect

Replying Settings 115automatically put new message in the queue 45
Copy original’s priority to reply 36, 44, 116no signature 46
Include yourself 44Redirect command 45
Put original To recipients in Cc field 44Redirect To submenu 46
Reply to all By default 44Turbo redirect by default option 46, 119
Reply to all option 115Turbo Redirect To submenu 45
When replying to all option 116Turbo Redirect Without Delete To submenu 45

Require control key for text/message dragging
option 120

Redirect command 45, 126
and styled text 37, 45

Requirements 13Redirect To action 76
resize cursor ( ) 63Redirect To submenu 46, 90, 127

with the option key 45 Return address option 103, 107
Redirected (D) status 45 and UUCP 162
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Return key 50 Send message Right Now option 41
Return receipt Send on check option 106, 107

how to remove request without sending 53 Send Queued Messages command 41
how to send 52 sending queued mail when checking mail 43

Return switches among header fields option 118 Send Message Now command 127
RFCs 141 Send message Right Now option 41
Right Now option 42 Send Messages Now command 40
rsrc 144 Send on check option 43, 106, 107

Send Queued Messages command 41, 123
Send to Back command 129

S Sendable (•) status 24, 34, 42, 43
Sender/Recipient column 62S, in the Status column 46, 61
Sending Mail Settings 107Save All command 123

Domain to add to unqualified names option
107

Save As command 81, 123
Save command 24, 34, 86, 123

Fix curly quotes option 108Save mail as text
Immediate send 40, 41as a single file 81
Immediate send option 107Guess Paragraphs option 81
Keep copies of outgoing mail 46Include Headers option 81
Keep copies of outgoing mail option 108TEXT files belong to option 82
May use Quoted-Printable option 108Save password option 49, 106
Return address option 107Say OK to alerts after 2 minutes option 114
Send on check 43Screen Font, Size, and Text Color options 110
Send on check option 107Scripting 148
SMTP Server option 107Scripting, and dialups 143
Use signature option 108Search button 79
Word wrap option 108Search mailbox option 80

Sent (S) status 46Search mailfolder option 80
Server Options action 76Search To End option 80
Set a changed message back to read-only option
115

Searching for text
in messages, mailboxes, and folders 79

Settings command 101, 129Select All command 124
Settings Icons Settings 121Send Again command 46, 126
Sharing a Macintosh 95Send button 25, 33, 40
Show Balloons commandSend mail

on Macintosh Help menu 22all at once 41
Show columns options 122at a certain time 41
Signature command 35Change Queueing dialog 40
Signature popup 32Immediate send option 40, 41, 107
Signatureskeeping copies of outgoing mail 108

and redirect 46May use Quoted-Printable option 108
creating or modifying the Alternate 35replies 43
creating or modifying the standard 35Send button 40
including in a message 35Send Message Now command 40
including in all messages 36
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Use signature option 108 When receiving styles, pay attention to option
122Signatures command 35

Signatures submenu 129 Subject column 62
Simple Mail Transfer Protocol 139 Subject field
Size column 62 changing in message summaries 55
Skip messages over ? K option 57, 106 in Filters 73
Skip Rest action 72, 76 in incoming mail 52
SMTP 139, 140 in outgoing mail 23, 33
SMTP option 104 Summaries only option 80
SMTP Server

and UUCP 162
TSMTP server hostname 145

SMTP Server option 107 T, in the status column 42, 61
Sort Descending submenu 128 Tab to switch fields, option-tab to insert tab option

118Sort submenu 77, 128
Sorting 77 Tabs

Correct (but slow) international sorting option
120

and the Save As command 81
inserting 118

Group Subjects option 77 switching fields 118
in descending order 77 TEXT files belong to option 82, 110
Re-sort mailboxes less often option 119 Timed (T) status 42
sticky 77 Timeout 146
with the shift key 77 Title Bar

Space bar 50 for incoming mail 51
Special menu 128 for outgoing mail 31
Srialpop 147 To button
Starting field 79 in the Address Book 86
starts with option 74 To field
Status in a reply 43, 44

-, never sent 61 in Filters 73
<blank>, read or unsendable 61 in outgoing mail 23, 33
D, redirected 45, 61 Tow Truck icon 52
F, forwarded 44, 61 Transfer menu 128
Q, queued 41, 42, 43, 61 Transfer To action 72, 76
R, replied 43, 61 Transferring mail to another mailbox
S, sent 46, 61 and creating a mailbox or folder 70
T, timed 42, 61 by dragging it 70
•, sendable or unread 24, 34, 42, 43, 50, 61 by dragging the Tow Truck icon 70

Status column 61 using the option key 70
Sticky sort 77 using the Transfer menu 70
Styled text Transferring mail to the Out mailbox 70

dragging 37 Trash attachments with messages option 69, 110
pasting 37 Trash command 125, 128
viewing and copying 37 Trash mailbox 46, 69

Styled Text Settings 37, 52, 121
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Troubleshooting 96 Use an alert option 50, 113
“-ERR Maildrop lock busy” 98 Use Folder button 54
“A TCPClose command was already issued”
99

Use old-style “.toc” files option 120
Use signature option 108

“Connection came up halfway then failed” 99 UUCP 161
“Error opening your settings file” 97 Working files 163
“Mailbox has a damaged table of contents” 99 D.mac0 ###
“Memory is tight” 97 X.mac0 ###
“Message columns don’t line up” 100 UUCP/Connect 161
“Messages not wrapping correctly” 100 uupc 161
“Need recipient” 97
“No Date header in your mail” 100

V“Password is incorrect” 98
“Random display problems” 100 View By option 84
and README file 96

Try something that requires too much memory
option 115 W

Try to delete any unsent mail option 69 Warnings
Try to delete any unsent messages option 114 Empty the Trash mailbox option 115
Try to delete queued mail option 69, 114 Set a changed message back to read-only

option 115Try to delete unread mail option 69, 114
Try to queue a message with no subject option 114 Try something that requires too much memory

option 115Try to quit with messages queued to be sent option
115 Try to delete any unsent mail option 69
Try to send a message whose size is more than ? K
option 115

Try to delete any unsent messages option 114
Try to delete queued mail option 69, 114

Turbo redirect by default option 46, 119 Try to delete unread mail option 69, 114
Turbo Redirect To submenu 45, 127 Try to queue a message with no subject option

114with the option key 46
with the shift key 45 Try to quit with messages queued to be sent

option 115Turbo Redirect Without Delete To submenu 45,
127 Try to send a message whose size is more than

? K option 115
Waste cycles drawing trendy 3D junk option 111U
When receiving styles, pay attention to option 122

Undo command 124 When replying to all option 116
unless option 75 Whole word option 79
Unqualified name, adding domain 107 Window menu 129
Unread (•) status 50 Windows
Unwrap Selection command 37, 124 sending to the back 129
URL zooming 111

choosing an application 55 Word Wrap icon 32, 37
in incoming mail 55 Word wrap option 108
in outgoing mail 40 Wrap Selection command 37, 124
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Wrapped text 32, 37
Write to Internet Config option 120

X

X-Attachments field
in outgoing mail 23, 34, 38

Y

You have new mail alert 26
You have no new mail alert 26

Z

Zoom windows when opening option 111
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